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1 Preliminary note
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1.1 Legal and copyright information
1631

© All rights reserved by ifm electronic gmbh. No part of this manual may be reproduced and used
without the consent of ifm electronic gmbh.

e All product names, pictures, companies or other brands used on our pages are the property of the
respective rights owners:

o AS-iis the property of the AS-International Association, (— www.as-interface.net)
e CAN is the property of the CiA (CAN in Automation e.V.), Germany (— www.can-cia.orq)

e CODESYS™ is the property of the 3S — Smart Software Solutions GmbH, Germany
(— www.codesys.com)

e DeviceNet™ is the property of the ODVA™ (Open DeviceNet Vendor Association), USA
(— www.odva.orq)
e EtherNet/IP®is the property of the = ODVA™

e EtherCAT® s a registered trade mark and patented technology, licensed by Beckhoff Automation
GmbH, Germany

e |O-Link® (— www.io-link.com) is the property of the —PROFIBUS Nutzerorganisation e.V.,
Germany

e ISOBUS is the property of the AEF — Agricultural Industry Electronics Foundation e.V.,
Deutschland (— www.aef-online.org)

e Microsoft® is the property of the Microsoft Corporation, USA (— www.microsoft.com)

e PROFIBUS® is the property of the PROFIBUS Nutzerorganisation e.V., Germany
(— www.profibus.com)

e PROFINET® is the property of the —PROFIBUS Nutzerorganisation e.V., Germany
e Windows® is the property of the —Microsoft Corporation, USA

1.2 Purpose of the document

1618
This document applies to the following device of the type "SmartSPS Dataline AC14":
e SmartPLC DatalLine with Profinet-DP interface (AC1403/AC1404)
e SmartPLC DatalLine with EtherNet/IP device interface (AC1423/AC1424)
e SmartPLC DataLine with EtherCAT slave interface (AC1433/AC1434)

It is part of the device and contains information about the correct handling of the product.
» Read this document before using the device.
» Keep this document during the service life of the device.


http://www.as-interface.net/
http://www.can-cia.org/
http://www.codesys.com/
http://www.odva.org/
http://www.io-link.com/
http://www.aef-online.org/
http://www.microsoft.com/
http://www.profibus.com/
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1.3 Symbols and styles used

13839

» ... Instructions

> ... Reaction, result

— ... Cross-reference or internet link
123 Decimal number

0x123 Hexadecimal number
0b010 Binary number

[.] Designation of pushbuttons, buttons or indications

1.4 Overview: User documentation for SmartPLC DataLine AC14

6998

ifm electronic provides the following user documentation for the models of the device class "SmartSPS
DataLine AC14™

Document Content / Description
Data sheet Technical data of the device as a table
Operating instructions * = Notes on mounting and electrical installation of the device
= Set-up, description of the operating and display elements, maintenance information, scale
drawing
Device manual = Notes on operation of the device via GUI and web interface

= Error elimination
= Description of the fieldbus data

Supplement device manual = Description of the acyclic data sets and the command interface

Programming manual = Creation of a project with the device using CODESYS

= Configuration of the device using CODESYS

= Programming of the SPS of the device

= Description of the device-specific CODESYS function libraries

*... The operating instructions are supplied with the device.

The user can download all documents from the ifm website.

i
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1.5 Overview: CODESYS documentation of 3S

18296
3S GmbH provides the following user documentation for programming SPS of AC4S:

Document Content / Description

Online help = Context-sensitive help
= Description of the CODESYS programming system
= Description of components and function libraries

CODESYS installation and
first steps .

Remarks about the installing of the CODESYS programming system
First steps for handling the CODESYS programming system

After the installation of the CODESYS 3.5 programming system all documents are stored on the hard
disk of the PC/laptop and can be accessed:

e Online help:
...\Program Files\3S CoDeSys\CoDeSys\Online-Help

e CODESYS installation and first steps:
...\Program Files\3S CoDeSys\CoDeSys\Documentation

1.6 Modification history

21676

Version Topic Date

00 New creation of document 12/2017
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2 Safety instructions

Contents
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213

2.1 General safety instructions

8516
Read this document before setting up the product and keep it during the entire service life.
Only use the product for its intended purpose.

If the operating instructions or the technical data are not adhered to, personal injury and/or damage to
property may occur.

Improper or non-intended use may lead to malfunctions of the device, to unwanted effects in the
application or to a loss of the warranty claims.

The manufacturer assumes no liability for any consequences caused by tampering with the device or
incorrect use by the operator.

» Observe these operating instructions.
» Adhere to the warning notes on the product.

2.2 Required background knowledge

13323
This document is intended for people with knowledge of control technology and PLC programming to
IEC 61131-3.
To program the PLC, these people should also be familiar with the CODESYS software.

This document is intended for specialists. Specialists are people who, based on their relevant training
and experience, are capable of identifying risks and avoiding potential hazards that may be caused
during operation or maintenance of the product. The document contains information about the correct
handling of the product.

» Read this document before use to familiarise yourself with operating conditions, installation and
operation. Keep this document during the entire duration of use of the device.

» Follow the safety instructions.
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2.3 Warnings used

13685

Death or serious irreversible injuries may result.

A CAUTION

Slight reversible injuries may result.

Property damage is to be expected or may result.

] Important note
s Non-compliance may result in malfunction or interference.
i Information

Supplementary note.
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3 System requirements
Contents
L F= 10 1T LRSS 9
SO WA ..o, 9
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3.1 Hardware

8469

e Device of the SmartSPS DataLine AC14 product family with V4.2.x firmware

e PCllaptop for the programming system CODESYS (— system requirements CODESYS
Development System V3.5)

e Ethernet connection between CODESYS-PC/laptop and configuration interface 1 (X3) or 2 (X8) of
the device

3.2 Software

16905

To program the device-internal PLC of the SmartSPS DataLine AC14, the following software
components are required:

Component Description Release

CODESYS Development System Programming software CODESYS Development System | 3.5 SP9 Patch 7 Hotfix 3
fur PLC programming according to norm |IEC 61131-3

Package "CODESYS for ifm SmartPLC = Device and interface description of SmartPLC 1.6.4.14

DataLine" DataLine AC14

= Function libraries for programming of the SPS

] The assured characteristics and functions described in this manuals are only accessible with
s the indicated releases of the software components!
ifm electronic provides the software components for downloading on its website:
— www.ifm.com > Service > Download > Industrial communication
3.3 Licensing

20254

By buying a device of the SmartSPS DatalLine AC14 the buyer has also purchased a licence valid for
using the CODESYS 3.5 programming software.



http://www.ifm.com/
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4 Installation

Contents

CODESYS programming SOIWAIE .........cc.uuuiiiieeeeiiiiiiiie et e e ee st e e e e e e s eseatae e e e e e e e sesantaeeeeaesesanrnrneeeaeeaeas 10

1 NS T I = Tod = Lo =P PP PP PPPRP 11
17146

4.1 CODESYS programming software

7282
The CODESYS Development System (short: CODESYS) is a platform for the creation of PLC
applications according to the standard IEC 61131-3.
411 Install CODESYS Development System

18596

To install the software "CODESYS Development System":
» Install the programming system CODESYS 3.5 SP9 Patch 7 Hotfix 3 (— CODESYS installation and first steps).
> CODESYS 3.5 SP9 Patch 7 Hoffix 3 is installed on the programming PC/laptop.

10
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4.2 ifm AS-i Package

Contents
Components of the ifM PACKAGE.........cii i e e e e s e e e e e e e s st rreeeaaeeaas 11
INStall the IfM PACKAGE ... eiieeeeee et e e sttt e e e e e s et e e e e e e e e aanntaeaeeeaeeseannnteeeeeeaeeaannne 12
0T To Fo N L= = o] - Vo [T OSSRt 12
Uninstall the ifM PACKAGE ......uueiiiiie i e e e e e e s et e e e e e e e e anantaaaeeeaeeseaannnneneeeaaesannnnes 13
17679
1 » Familiarise yourself with the following CODESYS functions!
- = Package Manager
— Online help > CODESYS Development System > Manage packages and licences

421 Components of the ifm package

17550
To program the SmartPLC DataLine AC14, ifm provides the CODESYS package "CODESYS for ifm
SmartPLC DataLine" (short: ifm package). The ifm package (file:
ifm_SmartPLC_DatalLine_V1_6_4 14.package) contains the following components:

Component Description
AC14DL.devdesc.xml Device description of the basic module
ACnnnn_EthernetAdapterDL.devdesc.xml Device description of Ethernet interface 1

ACnnnn_EthernetAdapterDL_1.devdesc.xml | Device description of Ethernet interface 2

ACnnnn_EtherCAT_Master.devdesc.xml Device description of the EtherCAT master (extension of the Ethernet interface)

ACnnnn_Modbus_Master.devdesc.xml Device description of the Modbus master (extension of the Ethernet interface)

ACnnnn_Modbus_Slave.devdesc.xml Device description of the Modbus slave device (extension of the Ethernet
interface)

ACnnnn_Utils.library Function library with SmartPLC DataLine AC14 specific CODESYS function
blocks and data structures

ACnnnn_SYS_CMD.library Function library with function block for access to the command interface of
SmartPLC Dataline AC14 from a CODESYS application

AC14DL.template Template for AC14 Dataline

AC14DL.template.project Template for AC14 Dataline project

ACl4.ico Symbol image of the AC14

11
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422 Install the ifm package

7283

To install the package "CODESYS for ifm SmartPLC DatalLine":
Requirements:

> CODESYS 3.5 SP9 Patch 7 Hotfix 3 is installed on the programming PC/notebook.
1  Start CODESYS

» Start CODESYS with administrator rights.

> CODESYS programming interface appears.
2  Install the ifm package in CODESYS

» Select [Tools] > [Package Manager].

> Window [Package Manager] is displayed.

» Click on [Install...] to start the installation dialogue.

» Select the downloaded ifm package and carry out a complete installation.

> The [Package Manager] window displays the installed ifm package.

» Press [Exit] to close the package manager.

423 Update ifm package

12267

To update an installed package "CODESYS for ifm SmartPLC DataLine":
1 Download new version of the ifm package

» Got to the product page of the device on the ifm website.

» Download ifm_SmartPLC_DataLine_V1_6_4_14.package and save it on the CODESYS PCl/laptop.
2 Uninstall the old version of the ifm package

» — Uninstall the ifm package (— p. 13)
3 Install a new version of the ifm package

» — Install the ifm package (— p. 12)
4  Update device libraries
In the device tree: Click on [Device (ifm_SmartPLC_DataLine)].
Select [Project] > [Update Device].
[Update Device] windows appears.
Click on [Update Device] to start the update process.
New device libraries are loaded.
Project tree view is updated.
Click on [Exit] to close the Package Manager.
Save the project.

vvyVvVvvyVvyy

12
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424 Uninstall the ifm package

12270

To uninstall the package "CODESYS for ifm SmartPLC DatalLine":
1  Start CODESYS

» Start CODESYS with administrator rights.

> CODESYS programming interface appears.
2 Uninstall the ifm package
Select [Tools] > [Package Manager] to access the package manager.
Window [Package Manager] shows the installed packages.
Activate [Display version] checkbox.
The window shows the version numbers of the installed packages.
Select the package version to be uninstalled
Click on [Uninstall...] to uninstall the selected package.
The selected package version is uninstalled.
Click on [Exit] to close the Package Manager.

vvVvvyvyVvyvVvy

13
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ifm AS-i Package

5 Getting started

Contents
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5.1 Create CODESYS project

Contents
Create new project with SmartPLC Dataling ACLA.......ccccceiiiiiieiiieee e ieeciieee e e e e s s e e e e e s e snsnnneeeeeea s 16
Overview: Project structure with SmartPLC Dataling ACLA.........oovveeeiiiiiiiiiiee e ceceiieee e e e seinrneeea e e 17

» Familiarise yourself with the following CODESY'S functions!
= Create CODESYS project
— Online help > CODESYS Development System > Create and configure project

= Objects of the user interface
— Online help > CODESYS Development System > Reference user interface

15
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51.1 Create new project with SmartPLC DataLine AC14

17682

To avoid errors during manual system configuration, it is explicitly recommended to use the
project template from ifm electronic when creating the SmartSPS DataLine AC14 project in

CODESYS.

Qualifications

1

16

> All required software components are correctly installed (— Installation (— p. 10)).
> CODESYS successfully started.

Create a new project

» Select [File] > [New Project...].

> The window to enter the project properties appears:

[E] Mew Project

Categories: Templates:

----- {3 Libraries

L. Projects " g

Empty project ifm SmartPLC Dataline

—_

project
ifm SmartPLC SmartPLC Safeline
StandardLine Praj... project
. = . =

Standard project  Standard project with
Application Composer

|.ﬁ.n empty project |

Mame: 2 |MyProject |
Locationd |C:\MyProjects v|

| cance

» Set the following values:

1. [Templates]: Select [ifm_SmartPLC_DataLine Projeki].
2. [Name]: Enter project name
3. [Location]: Select the storage location of the project file.

» Click on [OK] to verify the entered values.

CODESYS creates a new project with SmartPLC DataLine AC14.

> The window [Devices] shows the device tree of the project (— Overview: Project structure with SmartPLC

DataLine AC14 (— p. 17)).
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2 Save the project
» Select [File] > [Save Project].
> CODESYS saves the project.

5.1.2 Overview: Project structure with SmartPLC Dataline AC14

8394

A CODESYS project contains all components for the programming and administration of PLC
applications. All components of a project are shown in the [Device] window in a hierarchic tree view.
CODESYS projects with a SmartPLC DatalLine AC14 have the following structure:

@ @

=] MyPraject
= ifm_SmartPLC_Dataline (ifm SmartPLI: Dataline)
+-Elll PLC Logic @
+ - g ASi Master 1 (ASi Master 1) @
+- 4= ASi_Master 2 (ASi Master 2) J
+ @ Fieldbus_Interface (Fieldbus Interface) —@

ﬂj ¥3 (Ethernet)
ﬂj %3 (Ethernet) . —@

Q)

[ifm_SmartPLC_DataLine] provides access to the settings of the SPS of the SmartPLC DatalLine AC14.
— Configure SPS (— p. 21)

[PLC Logic] contains the SPS applications of SmartPLC DataLine AC14
— Objects of a PLC application (— p. 27)

[ASi_Master_1] contains the process data images of the AS-i slaves at the AS-i master 1
— Access input and output data (— p. 30)

[ASi_Master_2] contains the process data images of the standard AS-i slaves at the AS-i master 2
— Access input and output data (— p. 30)

[Fieldbus_Interface] provides access to the input and output data of the fieldbus interface.
— Access input and output data (— p. 30)

[X3] offers access to the configuration options of the configuration interface 2 (X3)
— Extend fieldbus functionality (— p. 22) and — Change IP settings (— p. 21)

Q @ ©@ 6 ® O 0

[X8] provides access to the configuration options of the configuration interface 2 (X8)
— Extend fieldbus functionality (— p. 22) and — Change IP settings (— p. 21)
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5.2 Use CODESYS online help

6989

This manual only describes the integration, configuration and the programming of the SmartPLC
DataLine AC14 using the CODESYS development system.

For the description of user actions and user interface elements the CODESYS terminology will be
used.

Standard functions and methods of CODESYS will not be described. At the beginning of each section
there will be a reference to the corresponding chapters of the CODESYS online help.

To access the online help of the CODESYS development system:
» Start CODESYS.

> The CODESYS user interface appears.

» Press[F1].

> Online help of the CODESYS development system appears.

» Familiarise yourself with the CODESYS development system! In particular with the
following topics:
= Names and functions of the user interface elements
= Basic menu functions
= Programming techniques and methods for data retention
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5.3 Set the programming interface

18494

To download the created projects and applications to the device a valid network path between the
CODESYS programming system and the SPS of the device has to be selected.

5.3.1 Set network path of SPS

3846
The following interfaces can be configured as program interface:
e Ethernet configuration interface 1 (X3)
e Ethernet configuration interface 2 (X8)

In order to be able to set the communication path of the SPS, the device-internal SPS must be
active.

To activate the SPS:

» GUI/ web interface: Select u > /‘l?

» Inthe area [Activate CODESYS-PLC]: activate [Use PLC].
> SPSis active.

To access the device-internal SPS via the Ethernet configuration interface 2 (X8), the IP
address of the interface X8 must be configured as a virtual gateway in the communication
settings.

To configure the connection between the CODESYS programming system and the SPS of the
SmartPLC DatalLine AC14:

1 Preparations
» Connect CODESYS-PCl/laptop with the required configuration interface (X3 or X8) of the device.
» Optional: Adjust IP settings of the Ethernet interfaces.
2 Select communication settings
» In the device tree: double-click on the symbol [ifm_SmartPLC_DataLine]
» In the editor window: Click on [Communication settings].
> The editor window shows the communication settings of the PLC.
3 Select gateway
» Select the required gateway from the list [Gateway].
> List shows selected gateway.
4  Set communication path
Click on [Scan network...]
The window [Select device] appears.
Select the gateway node and click on [Scan network] to start the scanning process.
CODESYS scans the network for devices.
Window shows the network path and detected devices.
Select the node of [SmartPLC DataLine AC14].
= J“’:‘O Gateway-1
[T Dataline (122.168.82.101) [0301.B065]

vVvVvvyVvVy

V

Information field shows detailed information about the selected node.
» Click on [OK] to set the communication path to the SPS.
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> CODESYS can transfer data to the SPS of the SmartPLC DataLine AC14.
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6.1 Configure SPS

18961

» Familiarise yourself with the following CODESY'S functions!
= Generic device editor
— Online help > CODESYS Development System > Reference user interface >
Objects> object 'device' and generic device editor

The SPS is configured via the "Generic Device Editor" of the CODESYS programming system. The
programmer can access the device editor of the SPS via the following node in the device tree:

u Device (ifm SmartPLC Dataling)

To configure the device-internal SPS:

» In the device tree: Double-click on [ifm_SmartPLC_DataLine]

> The editor window shows device editor of the device-internal SPS.
» Configure SPS.

» Save the project to apply changes.

6.2 Change IP settings

14524

» Familiarise yourself with the following CODESY'S functions!

o Ethernet adapter configurator
— Online help > Fieldbus support > Ethernet adapter configurator

The Ethernet configuration interfaces 1 (X3) and 2 (X8) must not be participants of the same
EtherNet subnet. Non-compliance may result in connection problems between the CODESYS
programming system and the device.

» Configure IP settings so that interfaces X3 and X8 are part of different Ethernet subnets.

To change the IP settings of the Ethernet configuration interfaces 1 (X3) and 2 (X8):
1  Select Ethernet interface

» In the device tree: Double click on the requested Ethernet interface (X3 or X8)

> The editor window shows the Ethernet device editor.
2 Change IP settings

» Change IP settings of the Ethernet interface.

> Save the project to apply changes.
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6.3 Extend fieldbus functionality

Contents
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15782
6.3.1 Available fieldbus stacks
13978

Besides the fieldbus functionality defined in the hardware the device can be operated as fieldbus
device by a software extension. In this respect the user has to assign a fieldbus stack to the Ethernet
configuration interfaces 1 (X3) or 2 (X8) in CODESYS and configure it. The device supports the

following fieldbus stacks:

Description

Fieldbus

Further information

EtherCAT master

EtherCAT

— Use EtherCAT master (— p. 23)

Ethernet/IP scanner

EtherNet/IP

Modbus TCP master

Modbus TCP

Modbus TCP slave device

Modbus TCP

— Add fieldbus stack (— p. 26)
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6.3.2 Use EtherCAT master

Contents
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The device can also be operated as EtherCAT master. In this respect ifm electronic provides an
EtherCAT master stack for the CODESYS programming system 3.5. The user has to assign one of the
two Ethernet configuration interfaces (X3 or X8) to the EtherCAT master.

Add EtherCAT master

7475

Only one EtherCAT master can be used per device.

To add the EtherCAT master stack to the project:
Requirements:
» Open or create project with SmartPLC DataLine AC14.
1 Add EtherCAT master stack
» In the device tree: Right-click on [<CODESYS _Root>]
» In the context menu: select [Add device...]
> Window [Add Device] appears.
»

Set the following values:
1. [Vendor]: Select [ifm electronic].
2. In table: Select [EtherCAT Master].

Click on [Add Device] to add the selected device to the project.
Click on [Close] to close the window.
CODESYS adds EtherCAT master to the device tree.

v

M 4

CODESYS automatically adds an EtherCAT master call to the task with the shortest cycle
time.

For notes on the configuration of task processing: — Configure task processing (— p. 48)

o
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Configure EtherCAT master

7477

» Familiarise yourself with the following CODESYS functions!

=  EtherCAT master
— Online help > Fieldbus support > EtherCAT configurator > EtherCAT master

The user has to assign the Ethernet configuration interface 1 (X3) or 2 (X8) to the added EtherCAT
master.

1 Requirements

> CODESYS laptop/PC is correctly connected to the device.

> Network path of SPS is set (— Set the programming interface (— p. 19)).
2 Assign Ethernet interface
In the device tree: Double-click on [EtherCAT_Master (EtherCAT Master)]
Click on the [General] tab.
The editor window shows the configuration options of the EtherCAT master.
Click on [Browse...]
Window [Select Network Adapter] appears.
Select requested Ethernet interface (eth0 = X3 or eth1 = X8).
Click on [OK] to apply the selected Ethernet interface.
Field [Source Address (MAC)] shows the MAC address of the selected Ethernet interface.
Field [Network Name] shows the name of the Ethernet interface.
EtherCAT master is coupled with selected Ethernet interface.
3 Configure EtherCAT master

» Set the parameters of the EtherCAT master as requested.

> EtherCAT master is configured.

VVVvavVvv

Continue with: — Add and configure EtherCAT slave (— p. 25)
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Add and configure EtherCAT slave

7479

» Familiarise yourself with the following CODESYS functions!

= EtherCAT slave
— Online help > Fieldbus support > EtherCAT configurator > EtherCAT slave

To configure EtherCAT slaves for the operation with the EtherCAT master of the SmartPLC DataLine
AC14:

Requirements:
> EtherCAT master is added to the project and configured (— Add EtherCAT master (— p. 23)).
> Device description file of the EtherCAT slave has been downloaded (— manufacturer's website).
1  Optional: Add EtherCAT slave to the device repository
» Select [Tools] > [Device Repository...]
> Window [Device Repository] appears.
» Click on [Install...].
> Window [Install Device Description] appears.
» Select the device description of the EtherCAT slaves and click on [Open].
> CODESYS installs the device in the device repository.
2 Add EtherCAT slave
In device tree: Right-click on [EtherCAT_Master (EtherCAT Master)]
In the context menu: Select [Add device...]
Window [Add Device] appears.
Select the requested EtherCAT slave in the [Device] area.
Click on [Add Device] to add the selected device to the project.
Click on [Close] to close the window.
CODESYS adds the EtherCAT slave to the project.
3 Configure EtherCAT slave
» In device tree: Double click on the added EtherCAT slave.
> The editor window shows the configuration options of the device.
» Configure EtherCAT slave as requested.

vVyvyvyVvyy
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6.3.3 Add fieldbus stack

17702

» Familiarise yourself with the following CODESYS functions!

= Modbus configurator
— Online help > Fieldbus support > Modbus configurator

To declare the Ethernet interface as a fieldbus interface:
1 Create/load CODESYS project

» Create or load CODESYS project with the SmartPLC DataLine AC14.
2 Add fieldbus stack

» In the device tree: Right-click on [X3 (Ethernet)] or [X8 (Ethernet)].

» In the context menu: Select [Add device...].
> Window [Add Device] appears.
>

Set the following values:

1. [Vendor]: Select [<All vendors>].

2. In table: Select the requested fieldbus stack in the [Name] column.
3. [Name]: Enter name of the fieldbus stack.

» Click on [Add Device] to add the requested fieldbus stack to the project.

> Inthe device tree: CODESYS adds the selected fieldbus stack as sub-element of the Ethernet interface.
3 Configure the fieldbus stack

» Configure added fieldbus device.

» Save the project to apply changes.
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This chapter provides information about the programming of the SPS of the device.

» Familiarise yourself with the programming according to the standard IEC 61131-3!

7.1 Objects of a PLC application

7143

All objects of a SPS application are listed as subelements of the node [Application] in the device tree.
In the basic configuration a SPS application contains the following objects:

©

=-El| Pl.c Logic
=1} Application

m Library Manager _I_ @
] PLC_PRG (PRG) ————— @

+-[# Task Configuration

O,

[Application] is the container of the SPS application
[Library manager] provides access to the standard and device-specific function libraries.

[PLC_PRG (PRG)] provides access to the program editor of the application
— Create SPS application (— p. 28)

®©©® 0

@ [Task configuration] provides access to the settings of the task processing
— Configure main task (— p. 48)

If needed, the programmer can add additional objects to the PLC application (— Add visualisation to a
project (— p. 44)).
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7.2 Create SPS application

17691

» Familiarise yourself with the following CODESY'S functions!
=  Program application
— Online help > CODESYS Development System > Program application
*» Programming reference
— Online help > CODESYS Development System > reference programming

To create a SPS application:
» In device tree: Double-click on [PLC_PRG (PRG)]
> The editor window shows the programming surface:
if] PLC_PRG X - | | ToolBox ~ I
1 FPROGRAM PLC PRG 2 General
‘: VAR E [ Network
i END_VAR IF Box

100 % @ FF Box with EN/ENO
- =ik Assignment

=+ Jump
AreT Return
%] Input
= Branch
T Execute
+ Boolean Operators

+ HMath operators
+ Other Operators

k| 100 % |[E4 | + Function blocks
£ > £ >

» Program the application in the editor.

7.21 Use remanent variables

18522
The SPS of the device supports the use of remanent variables. Variables declared as VAR RETAIN
are stored in a memory area that is also maintained when the device is switched off.

The declaration of a variable as RETAIN also influences its behaviour when the SPS application is
reset (— Supported reset variants (— p. 57)).

The memory area for RETAIN variables comprises 4072 bytes.

» Pay attention to the maximum size of the RETAIN memory area when declaring RETAIN
variables!
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7.2.2 Supported programming languages

18034

The following table shows which programming languages according to IEC 61131 are supported by
the ifm function libraries:

Instruction List (IL)

Library

ACnnnn_Utils.library

> | > | Function Block Diagram (FBD)
x| X | sequential Function Chart (SFC)
> | >| continuous Function Chart (CFC)

x| Ladder Diagram (LD)
> | > | structured Text (ST)

X | X

ACnnnn_SYS_CMD.library

Legend:
X ... is supported

723 Change system time of the device

18271

A WARNING

Risk of undesired system behaviour!

The use of the CODESYS function SysTimeRtcSet for setting the time may lead to malfunction.

» To set the system time (date, time) of the device only use the following device-specific commands:
» Function block Set_DateTime (— Set_TimeDate (— p. 113))

=  System command 0x1109 with function block ACnnnn_SysCmd (— ACnnnn_SysCmd
(— p- 125))
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7.3 Access input and output data
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1 » Familiarise yourself with the following CODESY'S functions!
[

» Addresses according to IEC standard 61131-3:
— Online help > CODESYS Development System > Programming Reference >
Operanden > Addresses

= Access to IEC address via AT declaration:
— Online help > CODESYS Development System > Programming Reference >
Declaration > AT Declaration

= Definition of an ALIAS for an IEC address:
— Online help > CODESYS Development System > Programming Reference > Data
Types > References

=  Coupling of a program variable to an address (mapping):
— Online help > CODESYS Development System > Configuring 1/O Links

7.31 Options to access input and output data

17621

In a CODESYS project, each input and output has a physical address according to the IEC standard
(e.g. %IW5). CODESYS offers the following options to access this address from a SPS application
and thereby to access the input and outputs data of the device:

e Direct access to IEC address

e Access to IEC address via AT declaration

e Definition of an ALIAS for an IEC address

e Link a program variable to an IEC address (mapping)
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7.3.2 Validity of the interface data

18413

In order to facilitate the access to inputs and outputs of AS-i slaves, SmartPLC DatalLine AC14
projects offer clearly defined interfaces in the device tree (— Overview: Project structure with SmartPLC
DataLine AC14 (— p. 17)).

Depending on the active instance for accessing the outputs of the AS-i slaves (Manual, Gateway,
PLC), the CODESYS data mapper only updates certain address areas of the interfaces. The following
table shows which address areas of the i/o interfaces provide valid data values while in a certain
operating mode:

Output control 1/0 interfaces Updated address areas / channels
Manual [ASi_Master_1] AS-i 1 Input (%I1B, %IW)
[ASi_Master_2]* AS-i 2 Input (%IB, %IW)
[Fieldbus_lInterface] = AS-i 1 Output (%IB, %IW)
= AS-i 2 Output (%IB, %IW)
Gateway [ASi_Master_1] ASi 1 Input (%IB, %IW)
[ASi_Master_2]* AS-i 2 Input (%IB, %IW)
[Fieldbus_lInterface] = AS-i 1 Output (%IB, %IW)
= AS-i 2 Output (%IB, %IW)
PLC [ASi_Master_1] = AS-i 1 Input (%IB, %IW)

= AS-i 1 Output (%QB, %QW)

[ASi_Master_2]* = AS-i 2 Input (%IB, %IW)
= AS-i 2 Output (%QB, %QW)

[Fieldbus_Interface] = AS-i 1 Output (%IB, %IW)
= AS-i 2 Output (%IB, %IW)

* ... only available for devices with 2 AS-i masters

» When linking variables with inputs and outputs, only use interfaces in the project tree, that
are updated by the CODESYS data mapper!
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733 Process data of the AS-i slaves

17584

The project tree offers direct access to the cyclically updated process images of the inputs and outputs
of the AS-i slaves.

= a4 ASi_Master 1 (ASi Master 1) @
45 ASi_1 binaryIO (ASi_1_binaryIQ) _r
4 ASi_1 analoglO (ASi_1 analogld) —
= 4% ASi_Master_2 (ASi Master 2)
45 ASi_2 binarylO (ASi_2 binarylQ) —
4 ASi_2 analoglO (ASi_2_analoglO) 1

@ Digital input and output data of the slave at AS-i master 1: — Digital input and output data (— p. 33)
@ Analogue input and output data of the slaves at AS-i master 1: — Analogue input and output data (— p. 33)
@ Digital input and output data of the slave at AS-i master 2: — Digital input and output data (— p. 33)
@ Analogue input and output data of the slaves at AS-i master 2: — Analogue input and output data (— p. 33)

Consider validity of the interface data (— Validity of the interface data (— p. 31))!

The function library ACnnnn_Utils.library contains the complex variable ASi_NET. The
variable represents all inputs and outputs of a completely developed AS-i network. The
programmer can use this data structure to store the process images of the inputs and outputs
of an AS-i network. (— ASI_NET (STRUCT) (— p. 120))

o
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Digital input and output data

17625
To access the digital process data of the slaves at AS-i master 1:
» In the device tree: Double click on [ASi_1_binarylQ]
> The editor window shows a structured list of the digital inputs and outputs of the AS-i slaves.

Wariable Mapping Channel Address Type
= 4§ ASi Input bin %IB1
+ 4 Digital S(A) Slave %IE1  ARRAY [1..31] OF BYTE
o A Digital B Slave %IE32 ARRAY [1..31] OF BYTE
=- "¢ ASi Output bin %QB1
+- Ty Digital S{A) Slave %0QB1  ARRAY [1..31] OF BYTE
"y Digital B Slave %%QB32 ARRAY [1..31] OF BYTE

» In column [Variable]: Mouse click on # to make individual variables visible.

To access the digital process data of the slaves at AS-i master 2 in a system with 2 AS-i masters:
» Double click on [ASi_2_binarylQ]

i

Analogue input and output data
17626

To access the analogue process data of the slaves at AS-i master 1.
» In the device tree: Double-click on [ASi_1_analoglO]
> Editor window shows a structured list of the analogue inputs and outputs of the AS-i slaves.

Variable Mapping Channel  Address Type
+ Ay ASi Input BLIW32  ARRAY [1..31] OF SLAVEaAMAaIMETYPE
+- T ASi Output %0W32  ARRAY [1..31] OF SLAVEaANAOUTETYPE

» In column [Variable]: Mouse click on # to make individual variables visible.

To access the analogue process data of the slaves atAS-i Master2 in a system with 2 AS-i masters:
» Double-click on [ASi_2_analoglQ]

i
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734 Fieldbus data

17585

The device tree offers direct access to the data that is transmitted between fieldbus and device.

= @ Fieldbus_Interface (Fieldbus Interface)
& FieldBusData_ {FieldBusData )
r-E: ASi_1_binaryQut (ASi_1_binaryQut)
;E: ASi_1_analogQut (ASi_1_analogOut) @
:-E: ASi_2 binaryOut (ASi_2_binaryOut)
;E: ASi_2_analogQut (ASi_2_analogOut)

@ Data that the fieldbus transmits/receives via the fieldbus.
— Input and output data of the fieldbus interface (— p. 34)

@ Output data of the AS-i slaves at AS-i master 1 and AS-i master 2 that is transmitted by the higher-level fieldbus
PLC.
— Outputs data of the AS-i slaves (— p. 35)

Consider validity of the interface data (— Validity of the interface data (— p. 31))!

Input and output data of the fieldbus interface

17619

The input and output data of the fieldbus interface os transmitted in cycles of 120 words each. The
programmer can access this data via IEC addresses.

To access the input and output data of the fieldbus interface:
» Device window: In the project tree, double-click on [FieldBusData_]
> Editor window shows a structured list of the inputs and outputs:

Variable Mapping Channel Address Type
o M Inputs from fieldbus %eIW373 ARRAY [0..119] OF WORD
+- " Outputs to fieldbus 9LOW373  ARRAY [0..119] OF WORD

» In column [Variable]: Mouse click on * to make individual variables visible.
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Output data of the AS-i slaves

17620
The area contains all data, the higher-level Fieldbus controller cyclically sends to the outputs of the
AS-i slaves via the fieldbus network. The data is structure like an AS-i network. The programmer can
access this data via IEC addresses.

If the output access of the device is set to "PLC", the programmer can use the data bundled in
this area to process the target values sent by the higher-level fieldbus controller to the
CODESYS SPS.

i

Digital output data

17630
To access the digital output data of the slaves at AS-i master 1:
» Device window: In the project tree, double-click on [ASi_1_binarylQ]
> Editor window shows a structured list of the digital output data:

Variable  Mapping Channel Address Type

= " FB ASi Output bin YolB330
+o 4 Digital S{A) Slave %IB935  ARRAY [1..31] OF BYTE
+ oA Digital B Slave %IB1017 ARRAY [1..31] OF BYTE

» In column [Variable]: Mouse click on # to make individual variables visible.

To access the digital output data of the slaves at AS-i master 2 in a system with 2 AS-i masters:
» Double-click on [ASi_2_binarylO]

i

Analogue output data

17631
To access the analogue output data of the slaves at AS-i master 1:
» Device window: In the project tree, double-click on [ASi_1_analogOut]
> Editor window shows the structured list of the analogue output data:

Variable Mapping Channel Address Type
+- M FB ASi Output ana DLIWS24  ARRAY [1..31] OF SLAVEaAMASINSTYPE

» In column [Variable]: Mouse click on * to make individual variables visible.

To access the analogue output data of the slaves at AS-i master 2 in a system with 2 AS-i masters:
» Double-click on [ASi_2_analogOut]

i
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7.4 Use functions of the ifm package

18489

The CODESYS package "CODESYS for ifm SmartPLC DataLine" offers different functions for the
programming of the device-internal CODESY'S controller. In the following sections, these functions will
be briefly described. To make orientation easier, the functions are grouped according to corresponding
subjects and provided with a cross-reference to a detailed explanation in the document's appendix.

741 Control interface of the ifm function blocks

17660
All function blocks (FB) of the libraries ACnnnn_Ultils.library and AChnnn_SYS_CMD.library have
inputs and outputs for control signals. The inputs activate the execution of the function block. The
outputs provide information about the internal condition of the function block. Thanks to the signals,
the programmer can create a control structure for a targeted processing of the FB and react to
possible errors.

Number and designation of the FB control signals provide information about the type of FB execution:

FB with one-time execution

17140
These function blocks perform their function exactly once after activation. To execute the function
once again, the FB needs to be reactivated. FBs of this kind feature a control interface with the
following inputs and outputs:

Designation Type Data type |Description Possible values
xExecute Input BOOL Control FB execution FALSE Stop FB execution
TRUE Start FB execution
xReady Output BOOL Indication of whether execution of [ FALSE FB execution not yet completed
the FB has been completed -
TRUE FB execution completed
xBusy Output BOOL Indication of whether FB is active | FALSE Function block is inactive
TRUE FB is active
XError Output BOOL Indication of whether faults have | FALSE FB executed correctly
occurred during execution of the - -
EB TRUE Error occurred during execution of
the FB
wDiagnostic Output WORD Error code FB specific

The following figure shows the relation between the connections of the control signals:

xExecute

Irr

xReady

xBusy

XError

r Ir Ir
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xExecute = TRUE:
xBusy = TRUE:

XReady = TRUE:
xBusy = FALSE:
xError = FALSE:

xExecute = FALSE:

Rising edge (FALSE — TRUE) starts execution of the FB.
FB execution has been started, but has not yet been completed.

FB execution completed; there are valid values on the data outputs.
FB is no longer active.
FB execution without faults.

All signal outputs are set to FALSE and all internal states are reset.

—>®

XReady = TRUE:
xBusy = FALSE:
XError = TRUE:

NO)
NO

XExecute = FALSE:

FB execution is terminated.
FB is no longer active.

@0 OO © O

internal states are reset.

FB with cyclic execution

Errors occurred during FB execution; wDiagnostic provides error code.

FB execution interrupted prior to completion; All signal outputs are set to FALSE and all

17141

Function blocks which, when activated, cyclically perform their function until they are deactivated have

the following control inputs and outputs:

Designation Type Data type [Description Possible values
xEnable Input BOOL Control FB execution FALSE Stop FB execution
TRUE Start FB execution
xActive Output BOOL Indication of whether execution of [ FALSE FB execution not yet completed
the FB has been completed -
TRUE FB execution completed
xError Output BOOL Indication of whether faults have FALSE FB executed correctly
occurred during execution of the - -
FB TRUE Error occurred during execution of
the FB
wCycleCount Output WORD Counters for the FB cycles Integer value (hexadecimal representation)
wDiagnostic Output WORD Error code FB specific
74.2 Configure system

To configure the system of the device, use the following function blocks:

17450

Name Description

Reference

QuickSetupASi_Master Execute quick setup routine on an AS-i master

— QuickSetupASi_Master (— p. 111)

Set_TimeDate Set system time (date, time) of the system

— Set_TimeDate (— p. 113)

Get_Fieldbusinfo Read fieldbus type, the status of the field bus connection

and the parameters of the fieldbus interface

— Get_Fieldbusinfo (— p. 109)
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743 Configure AS-i master

17448
To configure the AS-i masters of the device, use the following function blocks:

Name Description Reference

Set_Mode Set operating mode of the AS-i master (projecting mode | — Set_Mode (— p. 95)
or protected operation)

Set_ASi_Config Set diagnostic functions of the AS-i master (double — Set_ASi_Config (— p. 91)
address recognition, earth fault detection)

Set_AdressMode Set automatic addressing of the AS-i master — Set_AddressMode (— p. 89)

744 Configure AS-i slaves

17449
To configure the AS-i slaves, that are connected to the device, use the following function blocks:

Name Description Reference
Set_SlaveAddress Change address of an AS-i slave — Set_SlaveAddress (— p. 100)
Set_SlaveParameter Change /O configuration and ID codes (IO, ID, ID1, ID2) | — Set_SlaveParameter (— p. 104)

of an AS-i slave

Set_SlaveExtendedID1 Extended ID1 of an AS-i slave — Set_SlaveExtendedID1 (— p. 102)
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74.5 Manage AS-i network

17126
To manage the AS-i networks controlled by SmartPLC DatalLine AC14, use the following function
blocks:

Use complex variables

18528
There are different complex variables (STRUCT) at the programmer's disposal. They bundle logically
associated data sets. Thereby, they facilitate the organisation of the data storage in the application
and at the same time reduce the error rate when variables are declared.

The following complex variables are available:

Name Description Reference
ASI_NET The complex variable contains the complete process image | — ASI_NET (STRUCT) (— p. 120)
(inputs and outputs) of an AS-i network.
ASI_DATA The complex variable contains the following components: — ASI_DATA (STRUCT) (— p. 117)
= Slave lists (LPS, LDS, LAS, LPF, LCE, LCEMS, LCEAS, | — Get_ASi_Data (— p. 106)
LDAE)

= Parameter images (PI, PP)
= Configuration data of the AS-i slaves (CDI, PCD)

Change network settings

17568

Name Description Reference
Set_ProjectAll Execute projection adaptation on one AS-i master — Set_ProjectAll (— p. 99)
Set_LPS Change list of the projected slaves (LDS) — Set_LPS (— p. 93)
Set_PCD Change permanent projecting data (10, ID, ID1, ID2) of | — Set_PCD (— p. 97)

all slaves on the AS-i master
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Read network settings

18532
To read the network settings cyclically and offer them in the application:
Name Description Reference
Get_ASi_Data Read the following datasets for network management in | — Get_ASi_Data (— p. 106)
batches and cycles:
= List of activated slaves (LAS)
= List of detected slaves (LDS)
= List of projected slaves (LPS)
= List of peripheral faults (LPF)
= List of configuration errors (LCE)
= List of configuration errors, missing slaves (LCEMS)
= List of configuration errors - additional slaves
(LCEAS)
= List of double address errors (LDAE)
= Configuration data image (CDI)
= Permanent configuration data (PCD)
= Input parameters (PI)
=  Qutput parameters (PP)
Alternatively, this data can be read separately with the following FB:
Read parameter images
17569
Name Description Reference
Get_InputParameter Read parameters of the inputs of the slaves at the AS-i | — Get_InputParameter (— p. 85)
master (PI)
Get_OutputParameter Read parameters of the outputs of the slaves on the — Get_OutputParameter (— p. 87)
AS-i master (PP)
read slave lists
18530
Name Description Reference
Get_LPS Read list of projected slaves (LPS) — Get_LPS (— p. 69)
Get_LDS Read list of detected slaves (LDS) — Get_LDS (— p. 67)
Get_LAS Read list of activated slaves (LAS) — Get_LAS (— p. 65)
Get_LPF Read list of peripheral faults (LPF) — Get_LPF (— p. 79)
Get_LCE Read list of configuration errors (LCE) — Get_LCE (— p. 71)
Get_LCEMS List of configuration errors - read missing slaves — Get_LCEMS (— p. 75)
(LCEMS)
Get_LCEAS Read of the configuration errors - read additional slave | — Get_LCEAS (— p. 73)
(LCEAS)
Get_LDAE Read list of double address errors (LDAE) — Get_LDAE (— p. 77)
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Read configuration data of the slaves

18533

Name Description

Reference

Get_CDI Read configuration data image (10, ID, ID1, ID2) of all
slaves on the AS-i master

— Get_CDI (— p. 81)

Get_PCD Read permanent configuration data of all slaves (IO, ID,
ID1, ID2) on the AS-i master

— Get_PCD (— p. 83)

Read status of the voltage supply

18529

Name Description

Reference

Get_ASi_PHY_Dat Determine voltage supply status of the AS-i network

— Get_ASi_PHY_Dat (— p. 63)
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7.4.6 Send commands to the system and the AS-i master

17659

Similar to the acyclic transmission command channels and data sets of the device, the programmer
can send commands to the system or an AS-i master with the FB AChnnn_SysCmd
(— ACnnnn_SysCmd (— p. 125)).

e System command overview: — Table: System commands (— p. 126)
e Overview AS-i master commands: — Table: AS-i master commands (— p. 127)

i By default, the FB ACnnnn_SysCmd is hidden. To add the FB to a program module:
» Highlight the required network and add an empty function block with [FBD/LD/IL] > [Insert Empty Block].
> Network shows empty FB. 1 290
» Double-click on the name field of the FB AChrmn_SysCud e
» Enter designation ACnnnn_SysCmd and Py —
confirm with [ENTER]. 297 —
>  FB has inputs and outputs of the ACnmrn_sysCmd_0
ACnnnn_SysCmd. AChINnn SysCmd
» Adjust inputs and outputs of the FB in Py —Execute a uCount
accordance with the required command. 727 —uConnandID xBeady— 727
7?2 —muTarget xError—z227?
272 —phataln UErrorCode — 222
22 —uSizeln
?r2 —phatalut
77 —uaizelut
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7.5 Use visualisations
Contents
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17059
1 » Familiarise yourself with the following CODESY'S functions!
[

» Visualisations in CODESYS
— Online help > CODESYS visualisation

7.51 Supported visualisation types

17661
The SmartPLC DatalLine AC14 supports the following CODESYS visualisation types:
e Web visualisation (WebVisu)
A WebVisu allows graphic representation of selected process and control data of the device in a
web browser by means of a user-specific visualisation.
e Target visualisation (TargetVisu)

A TargetVisu allows graphic representation of selected process and control data of the device on
the display of the device by means of a user-specific visualisation.
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7.5.2 Add visualisation to a project

17060
To add a visualisation to a CODESY'S project:

» Open CODESYS project.
OR:
Create new CODESYS project. (— Create new project with SmartPLC DataLine AC14 (— p. 16))

In the device tree: Click on [Application].
Select [Project] > [Add Object] > [Visualization...]
[Add Visualization] window appears.
Enter a designation for the visualization in the [Name] field and click on [Add] to apply.
CODESYS adds the following elements to the device tree:
=-E}l] PLC Logic
=i} Application

m Library Manager

] PLC_PRG (PRG)

= @ Task Configuration

vVyvyy

* Visualization Manager —@
@I MyVisu _|_®

@ [VISU_TASK] provides access to the visualisation task properties (— Set parameters for visualisation task
(—p.48))

[Visualization Manager] provides access to the visualisation properties (— Configure visualisation (— p. 46))

® ®

[MyVisu] contains the area for the creation of the visualisation objects (— Create a visualisation (— p. 45))
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753 Create a visualisation

Create a seperate visualisation object for each target and web visualisation.

To create a visualisation for a SPS application:
» In the device tree: double-click on [Visualization]
> The visualisation editor with a tool box appears:

/@j MyVisu xl - |TDOBOK
= 0 E

> 1

3 =

==

Combo box array Tab control

» Create the visualisation using the tools.
» Save the project to apply changes.

b

-
Basic Commaon controls Alarm manager
1 Measurement controls
Lamps/Switches/Bitmaps Special controls
Dateftime controls Symbols Favorite
— EAR— 1
v
]
|
]
Label Combo box integer

17061
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754 Configure visualisation

6953
In order to change the properties of the created visualisations, choose one of the following options:

e Change properties of the web visualisation (— p. 46)
e Change the properties of the target visualisation (— p. 47)

Change properties of the web visualisation

17065
To change the attributes of the web visualisation:
» In device tree: Double click on [Web-Visualisierung]
> The editor window shows attributes of the web visualisation:

&b WebVisu x TargetVisu ] MyVisu -

Start Visualization: 1. MyWebvisu | I
Mame of .htm file: 2. | webvisu | |

Update rate {ms}: |2IZIIZI |

Default communication buffer size: |5EIEIIIIIII |

3.

Show used visualizations
i

Scaling options

(®) Fixed () Isatropic () Anisatropic
Client width: | 1280 |
Client height: | 1024 |

Presentation options

Antialiased drawing

»  Set the following values:
1. Field [Start Visualization]: Select the created web visualisation.
2. Field [Name of .htm file]: Enter name for HTML file (— Note).
3. Area [Scaling options]: Enter fixed width and height as shown.

In the field [Name of .htm file] enter the name by which the web visualisation is to be accessible in the web
browser (— Display web visualisation (— p. 59)).

» Use only lower case when entering the name!

» Save the project to apply changes.
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Change the properties of the target visualisation

To change the properties of the target visualisation:
» In device tree: Double-click on [TargetVisu]
> Editor window shows properties of the target visualisation.

8 Webvisu TargetVisu X @j MyVisu

Start Visualization: 1. | MyTargetVisu ||
IUpdate rate (ms): 200 |

2. Show used visualizations

Scaling options

() Fixed (®) Isotropic () Anisatropic
[ ] Use automatically detected client size

Use specified client size

Client width: | 176

Client height: |zzn

Presentation options
Antialiased drawing

» Set the following values:
1. [Start Visualization] field: Select the created target visualisation.
2. [Scaling options] area: Enter fixed width and height as illustrated.

» Save the project to apply changes.

17064
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7.6 Configure task processing
4109
] » Familiarise yourself with the following CODESY'S functions!
o

= Task configuration
— Online help > CODESYS Development System > application programmable > task
configuration

The processing of the tasks is controlled by parameters. The user can set the parameters for each
task separately

CODESYS automatically creates the following tasks and visualisations during project creation:

Name Description Note

[MainTask] Configuration of the main task (e.g. for main program — Configure main task (— p. 48)
[PLC_PRG (PRG)])

[VISU_TASK] Configuration of the task for processing visualisation — Set parameters for visualisation task (— p. 48)

7641 Configure main task

18412

The basic settings of the task characteristics cover the requirements of many applications. In the event
of non-optimum device performance the user must determine and set the optimum task characteristics
himself.

To change parameters of a task:

» In device tree: Double click on [Taskkonfiguration] > [MainTask]
> The editor window shows the configuration of the main task.

» Set the parameters as requested.

> Selected value is applied.

7.6.2 Set parameters for visualisation task
17066
] » Execute the visualisation task (VISU_TASK) with a priority that is as low as possible to
s avoid interruption of other tasks that are important for the core functions of the application.

» Execute the VISU_TASK in appropriate cyclic intervals to save the resources of the
device-internal CODESYS SPS of the fieldbus network.

Each visualisation is executed separately from the program code in a separate task. To set the
properties of the visualisation task:

» In the device tree: Double-click on [Task configuration] > [VISU_TASK]
> Editor window shows parameters of the visualisation task.

» Set the parameters as required.

» Save the project to apply changes.
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1.7 Testing the SPS application

18594

» Familiarise yourself with the following CODESY'S functions!

» Test and fault elimination
— Online help > CODESYS Development System > Testing and Debugging

To ensure permanent operation without errors in industrial environments, the created SPS application
must be tested in detail and possible faults must be remedied.
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8 Operation
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8.1 Transfer CODESYS project to device

Contents
ACHVALE CODESYS SPS ... ittt ittt e e ettt e e st e e e e st bt e e e sabaeeeeanbbeeeeanbeeeeesbbeeeesbbeeeeanes 52
Download the application t0 the AEVICE .........ccii i e ss e e e e s e s e e e e e e e e s aannnes 53
Delete application from SmartPLC Dataling ACLA .........ccccuuiiiiieeiie e e e e s e setaee e e e e e e s e snnveeeeeeaeesannnes 53
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18490
1 » Familiarise yourself with the following CODESYS functions!
[

= Compile project/application and transfer it to device
— Online help > CODESYS Development System > Transferring Applications to the
PLC

To save the CODESYS project on the device the following component must be transferred to the
device:

e application "Application" (— Download the application to the device (— p. 53))

» Observe notes on the operating modes of the SPS of the device!
— Operating states of the SPS (— p. 55)

ifm system solutions and CODESYS applications created by the user must not be saved and
executed on the device at the same time!

» Before loading an application to the device delete all ifm system solutions saved on the
device (— Device manual, Uninstall ifm apps)!

To be able to use an ifm system solution in a user project the functions must be integrated into
the project via libraries to be ordered separately.

» Contact the AS-i specialist of ifm electronic!
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8.1.1 Activate CODESYS SPS

17692
To enable the processing of the created SPS application, the device-internal CODESYS SPS must be
activated in the setup menu of SmartPLC DataLine AC14.
If the SPS application is to have a write access to the outputs of the AS-i slaves, the CODESYS SPS
must be activated additionally as controller instance of the AS-i slave outputs.

The following table shows the possible combinations of the parameters [Output access] and [Use PLC]
as well as the rights of the CODESYS SPS resulting thereof.

List Checkbox CODESYS SPS
[Output access] [Use PLC]
Programmable Access to Access to
AS-i inputs AS-i outputs
Gateway r no yes no
v yes yes no
Manual r no yes no
) yes yes no
PLC & - yes yes yes
Legend:
* o Value fixed (greyed out)

To set the operating mode of the device:
1 Select menu page

| 2 u>/‘g'

» Select [System settings] tab.
2 Set the controller instance of the outputs
» Select the requested controller instance of the AS-i outputs in the [Output access] list.
» Press [Accept selection] to activate the selection.
3 Activate CODESYS SPS
» Activate [Use PLC] checkbox.
> CODESYS SPS is active.
4  Optional: Adjust device cycle
» Select the requested device cycle time in the [Device cycle] list.
» Press [Accept selection] to activate the selected value.
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8.1.2 Download the application to the device

18593

To transfer the created application as boot project to the device:
Requirements:

> Network path is set (— Set network path of SPS (— p. 19)).

> Project tested.

> Allifm system solutions stored on the devie are deleted (— device manual: Uninstall ifm apps)
1  Build application

» In the device tree: Highlightt application as active application.

» Use [Build] > [Rebuild] to compile the active application.

> CODESYS generates program code.
2 Load application on the device

» Use [Online] > [Login] to connect with the device.

> Active application is transfered to the device (download).

> application on the device is in STOP state.
3 Create boot application

» Use [Online] > [Create boot application] to make the application bootable.

> application storage is non-volatile.
4  Start boot application

» Use [Debug] > [Start] to start the application.

> application goes to the RUN state.

8.1.3 Delete application from SmartPLC DataLine AC14

18030
To delete an application stored on the device:
1 Connect with the device
» In the device tree: highlight application as active application.
» Use [Online] > [Login] to establish connection to the device.
> CODESYS s in the online mode.
2  Delete application
» In the editor window: Select [Device] > [Applications] tab.
» Press [Refresh List] to refresh the view.
> List shows the applications that are stored on the device.
>

Delete all applications in the device with [Remove All].
OR:
Highlight requested application and press [Remove] to delete it from the device.

> Selected application will be deleted.
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8.14 Delete boot application via SD card

15970
If after the start of a complex boot application the device is overloaded and does not respond any
more to user inputs or login attempts, the boot application on the device needs to be forcibly deleted.

To delete the boot application on the device:

Disable the write protection of the SD card.

Create a file named KillBootApp.txt in the root directory of the SD card.
Insert the SD card into the SD card slot of the device.

Restart the device.

Boot application on the device-internal SPS is deleted.

The file Ki1l1BootApp.txt on the SD card is renamed in Kil1BootApp. rdy.

vVVyVvyvyy

i With this method the following data on the device-internal SPS is removed:
o allfiles of the boot application

e all CRC files

e directory with web and/or target visualisations

e datain the memory area F-RAM
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8.2 Operating states of the SPS

17544

This section provides information about the operating states of the device and the states of the SPS of
the device as well as information about the states of the applications.

8.21 Operating mode of the SPS

13769
The SPS of the device can be operated in the following modes:
e Offline mode

In the offline mode the user is logged out of the SPS or there is ho connection between
CODESYS and the SPS (e.g. connection loss).

e Online mode
In the online mode the user is logged in to the SPS.

8.2.2 States of the SPS application

4136

The applications saved on the device are executed independently in separate tasks. A application can
have the following states:

e Unload

No application is saved on the SPS.
¢ RUN

The application is executed (cyclically processed).
e STOP

The application is not executed.

Display operating state of the application

10272
To display the current operating state of the SPS choose one of the following options:
e CODESYS:

> In the device tree: Node of the application indicates the current state.
OR:

> Inonline mode the CODESYS status bar shows the current state of the application.
e GUI/web interface of the device:

> u>ﬂ>ﬂ

» Select the [Applications] tab.
> The page displays the operating states of the SPS applications saved on the device.
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8.2.3 Switch operating states

10264

To switch between the operating states of the application choose one of the following options:

Start SPS application

18027
To start a SPS application stored on the device:
e CODESYS:
In the device tree: highlight application as active application.
Use [Online] > [Login] to establish the connection with the CODESYS SPS.
Use [Debug] > [Start] to start the processing of the active application.
Application goes to RUN state.
Optional: repeat process for additional applications.
e GUI/web interface:

> u > ﬂ > f/J

Select the [Applications] tab.

Use [A]/[V¥]to select the required application.

Page shows the operating status of the selected application.

Press [Start] function key to start the processing of the selected application.
Application goes to RUN state.

Optional: repeat process for additional applications.

vVvyyvyy

vvvyVvyy

Stop SPS application

18029
To stop a SPS application stored on the device:
e CODESYS:
In the device tree: highlight application as active application.
Use [Online] > [Login] to establish the connection with the CODESYS SPS.
Use [Debug] > [Stop] to stop the processing of the active application.
Application goes to STOP state.
Optional: repeat process for additional applications.

vvVvyyvyy

e GUI/web interface:

9.39.%

Select [Applications] tab.

Use [A]/[V¥] to select the required application.

Page shows the operating status of the selected application.

Press [Stop] function key to stop the processing of the selected application.
Application goes to STOP state.

Optional: repeat process for additional applications.

vVvyvyvyy
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8.3.1 Supported reset variants
18613

The following table shows the reset variants supported by the device-internal CODESYS SPS and the
resulting system behaviour:

Type of reset

System behaviour

Triggering actions

Reset (warm)

application goes to STOP state.

Standard variables (VAR) of the application are
initialised.

Remanent variables (VAR RETAIN) of the
application keep their current values.

— Reset the application (warm) (— p. 58)

Reset (cold)

application changes to the STOP state.

All variables (VAR, VAR RETAIN) of the
application are initialised.

— Reset the application (cold) (— p. 58)

Reset (default)

application goes to STOP state.
The application on the SPS is deleted.

All variables (VAR, VAR RETAIN) of the
application are initialised.

SPS is reset to the default state.

— Reset the application (origin) (— p. 58)

o

A variable that has been declared without an initialisation value is initialised with the
variable-specific standard value (e.g. INT = 9).
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8.3.2 Reset the application (warm)

To reset the application on the SPS, choose one of the following options:

e CODESYS: command [Reset (warm)]

» In the device tree:
Highlight the required application as active application.

» Select [Online] > [Login] to establish a connection to the CODESYS SPS.
> CODESYS switches to online mode.
» Select [Online] > [Reset warm] to reset the application.

e GUI: command [Reset]

9.3
> >
» Select [All Applications] tab.

» Use [Reset] to reset all applications.
e GUI: command [Restart]

. N7

»  Select [System-reset] tab.
» Use [Restart] to reboot the device.

8.3.3 Reset the application (cold)

To reset the application on the SPS, choose one of the following options:

e Download the application to the device
» — Download the application to the device (— p. 53)
e CODESYS: command "Reset (cold)"

» In the device tree:
Highlight the required application as active application.

» Select [Online] > [Login] to establish a connection to the CODESYS SPS.
> CODESYS switches to online mode.
» Select [Online] > [Reset cold] to reset the application.

8.3.4 Reset the application (origin)

To reset the application on the SPS:
e CODESYS: command "Reset (origin)"

» In the device tree:
Highlight the required application as active application.

» Select [Online] > [Login] to establish a connection to the CODESYS-SPS.
> CODESYS switches to online mode.
» Select [Online] > [Reset origin] to reset the application.
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8.4 Display web visualisation

17063
To display the created web visualisation:
Requirements:

> PCllaptop is connected to the configuration interface (X3) of the device (— device manual: Configuration
interface: connection concepts)

CODESYS SPS appliation

» Download SPS application with web visualisation to the device and start it (— Download the application to the
device (— p. 53)).

» On PCllaptop: Start web browser.

» Enter the following in the address line and press [ENTER] to confirm:
<IP address-of-the-device>:<8080>/myvisu.htm

myvisu is the user-defined name of the visualisation (— Change properties of the web visualisation
(— p. 46)).

o

> Web browser shows the web visualisation of the device.

ifm system solution

» Install the ifm system solution on the device and start it (— device manual, Install single/basic app or Install
multi app).

» Display informationen about the installed ifm app (— device manual, Show information about installed ifm
apps).

» Call hyperlink of the ifm app.

> Web browser shows the web visualisation of the ifm system solution.

8.5 Display target visualisation

20256
After compilation of the project and download to the device the user has to start the target
visualisation:
e CODESYS/ higher-level Fieldbus controller:
» Execute system command [Display target visualisation] (— Device manual, Command 0x0110 - Display target
visualisation)
e GUI/web interface:

» Activate target visualisation via the menu (— Device manual: Show target visualisation)
OR:
Switch between target visualisation and menu with the key combination [«] + [P].

If the device does not react to the pressing of [d] + [P], the key combination is deactivated.
> Activate the key combination with the system command [Display target visualisation].
After a restart of the device the menu view of the GUI appears by default.

» With the FB ACnnnn_SysCmd (— p. 125)execute the system command [Display target
visualisation] at the start of the SPS application.

Further information: — Device manual: Command 0x0110 - Display target visualisation"
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9 Appendix

Contents

Library ACnnnn_Utils.library.........cccccoooiiiiiereee e
Library ACnnnn_SYS_CMD.library ........cccccoeceeiiiiineinnieeeenn,
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9.1 Library ACnnnn_Utils.library

Contents

OVErvieW: AS-i fUNCHONS (FB_ASI) . .uiiiiieiiiiiiiiieee ettt e e e e e st e e e e e e s e st e et e e e e e sanntnaneeeeeeaeannnnenneees 62
Overview: System fuNCtions (FB_SYSEM) .....uuuiiiiiiiiiiiiiiie e s e e e s e e e e e e s e e e e e e s e e nnnrnenees 108
Enumeration types and cOmMPIEX VariableS..........c..uuiiiiieii i e e e e e e e e 115
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9.1.1 Overview: AS-i functions (FB_ASi)

Contents

Get_ASI_ PHY _DaAt ....eiiiiiiiiiiiiiiiiee i
GO LAS L
GEE_LDS ...
GE_LPS .. e
GE_LCE .. oo
GEE_LCEAS ...
GEI_LCEMS ... oo
GEE_LDAE ... e
GE_LPE < e
GEE_CDI ..t
GEE PCD ...
Get_INPUIPAraMETEr .......coviiiiiiieeeie e
Get_OULPULPAIramMEeLEN ....uuu et
Set_ AddressMOde ........cooeeeiiiieiee e,
Set ASI_CoNnfig .ccoeeeeeeeeeeeee e,
S LIPS . . e
Set MOUE ..o,
SEELPCD ..o
S PIOJECIAIN ...ceiiieeiee e
Set_SIaVEAUAIESS ......oiiiiiiiie et
Set_SlaveEXteNdedIDL ........coccuiiiiiiiiiieiiiieee e
Set_SIaVeParameter .......c..ooiiiiiiieiiiieee e
(CT o] NS D L | - PP PP PP PPPPRPN

62



ifm Programming Manual SmartPLC DataLine AC14 (V4.2.x) 12/2017
Appendix Library ACnnnn_Ultils.library

Get_ASi_PHY_Dat

16005
Function block type: Function block (FB)
Library: ACnnnn_Utils.library

Symbol in CODESYS: Gek_ASi_PHY Dat
—=Execuke *PSF—

—endsi_Masker *PME—

*EF F—

*5E F—

*PF1 F—

*PF2 —
witoltagel —
whitoltage? —
iaymmetry F—
xReady—
*Busy —
xErrar —
whiagnoskic —

Description
16040

The FB reads the physical data of the selected AS-i master and provides the values.

Input parameters
16041

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16042
Parameter Data type Description Possible values
xPS BOOL Voltage source (Power Source) FALSE Unit is supplied via Aux.
TRUE Unit is supplied via AS-i.
xPM BOOL Power24-Modul (PM) FALSE Power24 module missing.
TRUE Power24 module is inserted.
xEF BOOL Earth fault FALSE No earth fault
TRUE Supply voltage is asymmetric,
earth fault suspected.
XSE BOOL Status of the earth fault detection FALSE Earth fault detection does not
provide valid data (e.g. when
AS-i voltage is lacking).
TRUE Earth fault detection provides
valid data.
xPF1 BOOL Voltage <22.5 V (power fail 22.5 V) FALSE No AS-i power fault (Classic
APF)
TRUE AS-i power fail (Classic APF),
i.e. AS-i voltage is below
225V
xPF2 BOOL Voltage <19.0V (power fail 19V) FALSE No AS-i power fail (24V-APF)
TRUE AS-i power fail (24V-APF), i.e.
AS-i voltage is below 19.0 V
wVoltagel WORD Voltage AS-i+ to AS-i- in mV
wVoltage2 WORD Voltage FE to AS-i in mV
iSymmetry INT Symmetry in % (-100% ... +100%) OxFF9C -100%
0x0000  |0%
0x0064 +100%
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:
= 0x0000
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Get LAS

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Utils.library

16008

—zExecute

Get_LAS

—endsi_Masker

dwlLAS_58_Slaves —
dwlas B Slaves —
xReady—

wBusy —

*Errar —
whiagnoskic —

16068

The FB reads the list of activated slaves (LAS) of the selected AS-i master and provides the values.

Input parameters

16069

Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16070
Parameter Data type Description Possible values
dwLAS_SA_Slaves DWORD List of the active S/A slaves. Each bit | Per bit:
represents an AS-i address:
* Bit0(LSB)=address 0 0 No single/A slave available
- 1 Single/A slave available
Bit 31 (MSB) = address 31/31A
dwLAS_B_Slaves DWORD List of the active B slaves. Each bit Per bit:
represents an AS-i address: -
« Bt (LSB) = not used 0 No B slave available
= Bit1=address 1B 1 B slave available
Bit 31 (MSB) = address 31B
XReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Get_LDS

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

16013

—zExecuke

Get_LDS

—enfsi_Maskter

dwlDS_54_Slaves —
dwlLD3_B_Slaves —
xReady —

xBusy —

*Error F—
whiagnoskic F—

16118

The FB reads the list of detected slaves (LDS) of the selected AS-i master and provides the values.

Input parameters

16119

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16120
Parameter Data type Description Possible values
dwLDS_SA_Slaves DWORD List of detected S/A slaves. Each bit Per bit:
represents an AS-i address:
* Bit0(LSB)=address 0 0 no slave detected
R 1 slave detected
= Bit 31 (MSB) = address 31/31A
dwLDS_B_Slaves DWORD List of detected B slaves. Each bit Per bit:
represents an AS-i address: 0 Mo S| detected
= Bit 0 (LSB) = not used o siave defecte
= Bijt1 = address 1B 1 Slave detected
= Bit 31 (MSB) = address 31B
XReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Get_LPS

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

16015

—=Execute

Get_LPS

—endsi_Masker

dwlPS_SA_Slaves —
dwlLPS_B_Slaves —
x¥Ready—

xBusy —

*xError —
whiagnostic F—

16130

The FB reads the list of projected slaves (LPS) at the selected AS-i master and provides the values.

Input parameters

16131

Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16132
Parameter Data type Description Possible values
dwLPS_SA_Slaves DWORD List of the projected S/A slaves. Each | Per bit:
bit represents an AS-i address:
* Bit0(LSB)=address 0 0 Slave not projected
R Slave projected
= Bit 31 (MSB) = address 31/31A
dwLPS_B_Slaves DWORD List of the projected B slaves. Each bit | Per bit:
represents an AS-i address: 0 I ororected
= Bit 0 (LSB) = not used §'ave not projecte
= Bit1=address 1B 1 slave projected
= Bit 31 (MSB) = address 31B
XReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Get_LCE

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)
ACnnnn_Ultils.library

Get_LCE
—=Execute

dwLCE_58_Slaves —

16009

—enhSi_Master

dwlE_B_Slaves —
wReady—

xBusy —

*Errar —
whiagnoskic —

16075

The FB reads the list of configuration errors (LCE) of the selected AS-i master and provides the

values.

Input parameters

16076

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16077
Parameter Data type Description Possible values
dwLCE_SA_Slaves DWORD List of configuration errors of the S/A | Per bit:
slaves. Each bit represents an AS-i
address: 0 No configuration error
= Bit0 (LSB) = address 0
1 Configuration error
Bit 31 (MSB) = address 31/31A
dwLCE_B_Slaves DWORD List of configuration errors of the B Per bit:
slaves. Each bit represents an AS-i - -
address: 0 No configuration error
* Bit0 (LSB) = not used 1 Configuration error
= Bit1=address 1B
Bit 31 (MSB) = address 31B
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Get_LCEAS

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)
ACnnnn_Ultils.library

16010

—=Execute
—enhSi_Master

Get_LCEAS

dwLCEAS_ S8 Slaves—
dwlCEAS B_Slaves —
wReady—

xBusy —

*Errar —

whiagnoskic —

16098

The FB reads the list of existing but not projected slaves (List of Configuration Error — Additional Slave

= LCEAS) of the selected AS-i master and provides the values.

Input parameters

16099

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16100
Parameter Data type Description Possible values
dwLCEAS_SA_Slaves | DWORD List of configuration errors of the S/A | Per bit:
slaves. Each bit represents an AS-i
address: 0 No configuration error -
= Bit0 (LSB) = address 0 additional slave
1 Slave exists, but not projected
Bit 31 (MSB) = address 31/31A
dwLCEAS_B_Slaves DWORD List of configuration errors of the B Per bit:
slaves. Each bit represents an AS-i - -
address: 0 No configuration error -
. itional slav
= Bit 0 (LSB) = not used additional slave
= Bijt1=address 1B 1 Slave exists, but not projected
Bit 31 (MSB) = address 31B
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Get_LCEMS

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)
ACnnnn_Ultils.library

16011

—=Execute
—enhSi_Master

Get_LCEMS

dwLCEMS_S8_ Slaves —
dwlLZEMS_E_Slaves f—
xReady —

*Busy —

*Errar —

whiagnoskic F—

16106

The FB reads the list of projected but missing slaves (List of Configuration Error — Missing Slave =

LCEMS) at the selected AS-i master and provides the values.

Input parameters

16107

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16108
Parameter Data type Description Possible values
dwLCEMS_SA_Slaves | DWORD List of configured but missing S/A Per bit:
slaves. Each bit represents an AS-i
address: 0 No configuration error -
= Bit0 (LSB) = address 0 missing slave
N 1 Slave is projected but not
Bit 31 (MSB) = address 31/31A available
sdwLCEMS_B_Slaves | DWORD List of the configured but non-existing | Per bit:
B slaves. Each bit represents an AS-i - -
address: 0 No configuration error -
. missing slavi
= Bit 0 (LSB) = not used ssing save
= Bijt1=address 1B 1 Slave is projected but not
available
Bit 31 (MSB) = address 31B
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Get_LDAE

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)
ACnnnn_Ultils.library

16012

Get_LDAE
—=Execute
—enhSi_Master

dwlLDAE_SA_Slaves —
dwlDAE_B_Slaves —
xReady —

*Busy —

*Errar —

whiagnoskic F—

16112

The FB reads the double address errors (LDAE) of the selected AS-i master and provides the values

in a list.

Input parameters

16113

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution

enASi_Master

ASI_MASTER Select AS-i master

Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16114
Parameter Data type Description Possible values
dwLDAE_SA_Slaves DWORD List of the double address errors. Per bit:
Each bit represents an AS-i address:
* Bit0(LSB)=address 0 0 No double address error
- Double address error
Bit 31 (MSB) = address 31/31A
dwLDAE_B_Slaves DWORD List of double address errors. Each bit | Per bit:
represents an AS-i address: 0 ~o double add
= Bit 0 (LSB) = not used 0 double address error
= Bijt1 = address 1B 1 Double address error
Bit 31 (MSB) = address 31B
XReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Unknown error
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Unknown command 1D
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Get_LPF

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

16014

—=Execute

Get_LPF

—enhSi_Master

dwlLPF_54_Slaves —
dwlPF_B_Slaves —
wReady—

xBusy —

*Errar —
whiagnoskic —

16124

The FB reads the list of peripheral faults (LPF) of the selected AS-i master and provides the values.

Input parameters

16125

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16126
Parameter Data type Description Possible values
dwLPF_SA_Slaves DWORD List of peripheral faults on S/A slaves. | Per bit:
Each bit represents an AS-i address:
* Bit0(LSB)=address 0 0 No peripheral fault
- 1 Peripheral fault detected
Bit 31 (MSB) = address 31/31A
dwLPF_B_Slaves DWORD List of peripheral faults on B slaves. Per bit:
Each bit represents an AS-i address: 0 N - heral fanlt
= Bit 0 (LSB) = not used O periphera” fau
= Bijt1 = address 1B 1 Peripheral fault detected
Bit 31 (MSB) = address 31B
XReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Get_CDI

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

16006

—=Execute

Get_CDI

—endsi_Masker

awi DI —
xReady —
*Busy F—
*Errar —
whiagnoskic F—

16045

The FB reads the configuration data (Configuration Data Image = CDI) of the slaves at the selected
AS-i master and provides the values in an array. The configuration data of a slave consists of the
registers 10, ID, ID1 and ID2.

Input parameters

16046

Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16047
Parameter Data type Description Possible values
awCDI ARRAY [0...63] | Configuration data of the slaves at the | Per Word:
OF WORD selected AS-i master Bits 0...3: 1/0-Code
Bits 4...7: ID-Code
Bits 8...11: ID1-Code
Bits 12...15: ID2-Code
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Unknown error
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Get_ PCD

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

16017

—=Execute

Get_PCD

—endsi_Masker

awPiZD —
wReady —
xBusy —
*Errar —
whiagnoskic F—

16141

The FB reads the projected configuration data (Projected Configuration Data Image = PCD) of the
slaves on the selected AS-i master and provides the values in an array.

Input parameters

16142

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16143
Parameter Data type Description Possible values
awPCD ARRAY [0...63] | Permanent configuration files of the per word:
OF WORD slaves on the selected AS-i master Bits 0...3: 1/0O-Code
Bits 4...7: ID-Code
Bits 8-11: ID1-Code
Bits 12-15: ID2-Code
@ Data in Word 0 is invalid!
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Unknown error
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Unknown command ID

Invalid parameters
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Get_InputParameter

Function block type:
Library:
Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

16007

—=Execute

Get_InputParameter

—enhSi_Master

abList_S&_Slave —
ablist_E_Slave —
xReady —

*Busy —

*Errar —
whiagnoskic F—

16056

The FB reads the input parameters of the slaves on the selected AS-i master and provides the values
in 2 arrays for single A slaves and B slaves.

Input parameters

16057

Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2

85




ifm Programming Manual SmartPLC DataLine AC14 (V4.2.x) 12/2017

Appendix

Library ACnnnn_Ultils.library

Output parameters

16058
Parameter Data type Description Possible values
abList_SA_Slave ARRAY]J0..31] List of output parameters of S/A Per byte:
OF BYTE slaves in the selected AS-i master. - i
Each byte contains the output Bits 0..3: | PO-P3
parameters of an AS-i slave.
— byte O (LSB) = res.
— byte 1 = slave with address 1(A) ...
— byte 31 = slave with address 31(A)
abList_B_Slave ARRAY]J0..31] List of output parameters of B slaves | Per byte:
OF BYTE in the selected AS-i master. Each byte [— ,
contains the output parameters of an | Bits 0..3: | P0-P3
AS-i slave.
— byte 0 (LSB) =res.
— byte 1 = slave with address 1B
— byte 31 = slave with address 31B
XReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Library ACnnnn_Utils.

library

Get_OutputParameter

Function block type:
Library:
Symbol in CODESYS:

Description

Function block (FB)
ACnnnn_Ultils.library

—=Execute
—enhSi_Master

Get_OutputParameter

ablist_5A_Slave
ablist_E_Slave
wReady

xBusy

*Errar
whiagnoskic

16016

The FB reads the output parameters of the slaves on the selected AS-i master and provides the
values for S/A slaves and B slaves in 2 separate arrays.

Input parameters

16136

16137

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2
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Output parameters

16138
Parameter Data type Description Possible values
abList_SA_Slave ARRAY]J0..31] List of output parameters of S/A Per byte:
OF BYTE slaves in the selected AS-i master. - i
Each byte contains the output Bits 0..3: | PO-P3
parameters of an AS-i slave.
— byte O (LSB) = res.
— byte 1 = slave with address 1(A) ...
— byte 31 = slave with address 31(A)
abList_B_Slave ARRAY]J0..31] List of output parameters of B slaves | Per byte:
OF BYTE in the selected AS-i master. Each byte [— ,
contains the output parameters of an | Bits 0..3: | P0-P3
AS-i slave.
— byte 0 (LSB) =res.
— byte 1 = slave with address 1B
— byte 31 = slave with address 31B
XReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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Set_AddressMode

16018
Function block type: Function block (FB)
Library: ACnnnn_Utils.library
Symbol in CODESYS: Set_addressMode
—xExecute wReady—
—enhSi_Master xBusy —
—enduto_address_Maode wErrar f—
whiagnoskic —
Description
16146
The FB activates/deactivates the parameter "Automatic addressing" for the selected AS-i master.
Input parameters
16147
Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB
execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2
enAuto_Address_Mode | ASI_ADDRESS_MODE | Parameter Auto_address_disable | Automatic

activates/deactivates the

automatic addressing mode.

addressing inactive

Auto_address_enable

Automatic
addressing active

89




ifm Programming Manual SmartPLC DataLine AC14 (V4.2.x)

Appendix

1212017
Library ACnnnn_Ultils.library

Output parameters

17017
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:
= 0x0000
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ifm Programming Manual SmartPLC DataLine AC14 (V4.2.x)

Appendix

1212017
Library ACnnnn_Ultils.library

Set_ASi_Config

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

—=Execute

Set_Asi_Config

—enhSi_Master
—xDaoubleAdrDetection
—xEarkhFaultDetection

16019
*Ready —
xBusy —
*Errar —
whiagnostic —
16149

The FB activates/deactivates the parameters "double address recognition” and "earth fault detection”
for the selected AS-i master.

Input parameters

16150

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2
xDoubleAdrDetection | BOOL Activate/deactivate "Double address FALSE Double address recognition
recognition” inactive
TRUE Double address recognition
active
xEarthFaultDetection BOOL Activate/deactivate "Earth-fault FALSE Earth-fault detection inactive
detection" - )
TRUE Earth-fault detection active
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Output parameters

17015
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:
= 0x0000
= 0x0001
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No specific error is set

Wrong parameter transferred, setting was not adopted.
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Set_LPS
16020

Function block type: Function block (FB)
Library: ACnnnn_Utils.library
Symbol in CODESYS: Set_LPS

—xExecute *Ready —

—enhSi_Master xBusy —

—dwLPS_ShA_Slaves wErrar —

—dwlLPS_E_Slaves whiagnoskic —
Description

16153
The FB changes the list of projected slaves (LPS) in the selected AS-i master.

Input parameters

16154
Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2

dwLPS_SA_Slaves DWORD List of the projected S/A slaves. Each | Per bit:
bit represents an AS-i address:
= Bit0 (LSB)=address 0 0 Slave not projected

R Slave projected
= Bit 31 (MSB) = address 31/31A

dwLPS_B_Slaves DWORD List of the projected B slaves. Each bit | Per bit:

represents an AS-i address:

. 0 slave not projected
= Bit 0 (LSB) = not used v proj

= Bit1l=address 1B 1 slave projected

= Bit 31 (MSB) = address 31B
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Output parameters

17016
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:
= 0x0000
= 0x0019
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No specific error is set

Master not in the projecting mode
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Set_Mode
16021
Function block type: Function block (FB)
Library: ACnnnn_Utils.library
Symbol in CODESYS: Set_Mode
—xExecute xReady —
—enhSi_Master *Busy F—
—enMade_ASi_Masker xErrar F—
whiagnostic F—
Description

16155

The FB changes the operating mode (protected operation, projection mode) of the selected AS-i
master.

Input parameters

16156

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution

TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1

Master_2 AS-i master 2

enMode_ASi_Master [ASI_MASTER_ | Operating mode of the AS-i master Closed_ protected mode active
MODE mode

Project_ projection mode active
mode
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Output parameters

17018
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:
= 0x0000 No specific error is set

= 0x0003 Slave with address 0 found (slave not detected)
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Set_PCD

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

—=Execute

Set_PCD

—enhSi_Master

—awPiD

*Ready —
xBusy —
*Errar —

whiagnostic —

The FB changes the configuration file (Permanent Configuration Data = PCD) of the slaves at the
selected AS-i master.

Input parameters

16022

16151

16160

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2
awPCD ARRAY [0...63] | Permanent configuration files of the per word:
OF WORD slaves on the selected AS-i master Bits 0...3: I/O-Code

Bits 4...7: ID-Code
Bits 8-11: ID1-Code
Bits 12-15: ID2-Code

@ Data in Word 0 is invalid!
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Output parameters

15574
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:
= 0x0000
= 0x0019
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No specific error is set

Master not in the projecting mode




ifm Programming Manual SmartPLC DataLine AC14 (V4.2.x)

Appendix

1212017
Library ACnnnn_Ultils.library

Set_ProjectAll

16023
Function block type: Function block (FB)
Library: ACnnnn_Utils.library
Symbol in CODESYS: Set_Projectall
—xExecute *Ready —
—enhSi_Master xBusy —
*Errar —
whiagnostic —
Description
16161
The FB starts the projection adaptation on the selected AS-i master.
Input parameters
16125
Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2
Output parameters
17020
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= 0x0003
= 0x0019

No specific error is set

Slave with address 0 found (slave not detected)

Master not in the projecting mode
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Set_SlaveAddress

Function block type:
Library:
Symbol in CODESYS:

Description

Function block (FB)
ACnnnn_Ultils.library

16024

—xExecute
—endsi_Masker
—enASi_Slave
—enAsi_sSlaveTyp
—enAsSi_Slave_new

—endsSi_SlaveTyp_new

Set_SlaveAddress

xReadyF—
*Busy F—
xErrar —
whiagnostic F—

The FB changes the address of the selected AS-i slaves.

Input parameters

16162

16165

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2
enASi_Slave ASI_SLAVE Address of the AS-i slave Slave_n AS-i slave to address n
(n=1..31)
enASi_SlaveTyp ASI_SLAVE_ Type of the AS-i slave SA_Slave | Single or A slave
TYP
B_Slave B-Slave
enASi_Slave_new ASI_SLAVE New address of the AS-i slave Slave_n AS-i slave at address n
(n=1..31)
enASi_SlaveTyp_new |[ASI_SLAVE_ New type of the AS-i slave SA_Slave |[single slave or A slave
TYP
B_Slave B slave
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Output parameters

17021
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= 0x0001
= 0x0002
= 0x0003
= 0x0004
= 0x0005
= 0x0006
= 0x0007
= 0x0008
= 0x0009
= 0x0018

No specific error is set

Slave does not respond or change to offline mode during FB execution

Slave with old address not found (slave not detected)
Slave with address 0 found (slave not detected)

Slave with new address found

Error during deletion of the old address (Delete Error)
ExtendedID1 could not be read after writing (Read Error)
Error when writing ExtendedID1 (Set Error)

New address temporary stored

ExtendedID1 stored temporarily

Master is not in normal operation.
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Set_SlaveExtendedID1

16025

Function block type: Function block (FB)

Library: ACnnnn_Utils.library

Symbol in CODESYS: Set_SlaveExtendedID1
—xExecute *Ready —
—enhSi_Master xBusy —
—endsi_Slave wErrar f—
—endsi_SlaveTyp whiagnostic —
—bExtendedID1

Description

The FB changes the Extended ID1 of the selected AS-i slave.

Input parameters

16169

16170

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2
enASi_Slave ASI_SLAVE Address of the AS-i slave Slave_n AS-i slave to address n
(n=1..31)
enASi_SlaveTyp ASI_SLAVE_ Type of the AS-i slave SA_Slave | Single or A slave
TYP
B_Slave B-Slave
bExtendedID1 BYTE Extended ID1 code of the selected Extended ID1 code
AS-i slave (hexadecimal representation)

102




ifm Programming Manual SmartPLC DataLine AC14 (V4.2.x)

Appendix

1212017
Library ACnnnn_Ultils.library

Output parameters

16148
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= 0x0003
= 0x0005
= 0x0006
= 0x0007
= 0x0009
= 0Ox000E
= 0x0018
= 0x0021

No specific error is set

Slave with address 0 found (slave not detected)

Error during deletion of the old address (Delete Error)
ExtendedID1 could not be read after writing (Read Error)
Error when writing ExtendedID1 (Set Error)
Extended|D1 stored temporarily

Invalid slave address (e.g. O or OB specified)

Master is not in normal operation.

Invalid ExtendedID1 code
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Set_SlaveParameter

16026

Function block type: Function block (FB)

Library: ACnnnn_Utils.library

Symbol in CODESYS: Set_SlaveParameter
—xExecute *Ready—
—enhSi_Master xBusy —
—endsi_Slave wErrar f—
—endsi_SlaveTyp whiagnostic —
—enASi_SlaveParam

Description

The FB changes the parameters of the selected AS-i slave.

Input parameters

16172

16173

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2
enASi_Slave ASI_SLAVE Address of the AS-i slave Slave_n AS-i slave to address n
(n=1...31)
enASi_SlaveTyp ASI_SLAVE_ Type of the AS-i slave SA_Slave | Single or A slave
TYP
B_Slave B-Slave
enASi_SlaveParam BYTE Parameters of the selected AS-i slave | Slave parameters
(hexadecimal representation)
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Output parameters

17025
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000 No specific error is set

=  0x0001 Slave does not respond or change to offline mode during FB execution
= 0Ox000A Sslave not in LAS

= 0x000B Data content invalid (e.g. parameter value >7 for A/B slaves)

= Ox000E Invalid slave address (e.g. O or OB specified)

= 0x0018 Master is not in normal operation.
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Get_ASi_Data
16000
Function block type: Function block (FB)
Library: ACnnnn_Utils.library
Symbol in CODESYS: Get ASi Data
—xEnable whckive —
—enASi_Master Wyl Cannk —
—pasi_Data *Error p—
whiagnostic —

Description

16033

The FB reads the following data from the selected AS-i master and stores the values in a structure

variable of data type ASI_DATA (— ASI_DATA (STRUCT) (— p. 117)):

List of activated slaves — LAS

List of detected slaves — LDS

List of projected slaves — LPS

List of configuration errors — LCE

List of configuration errors - additional slave — LCEAS
List of configuration errors - missing slave — LCEMS
List of peripheral faults — LPF

List of double address errors — LDAE

Configuration data image — CDI

Projected configuration data — PCD

Input parameters of the AS-i slaves

Outputs parameters of the AS-i slaves

Input parameters

16034

Parameter Data type Description Possible values
XEnable BOOL Control activiy of the FB TRUE FB is enabled
FALSE FB is disabled
enASi_Master ASI_MASTER Select AS-i master Master_1 AS-i master 1
Master_2 AS-i master 2
pASi_Data POINTER TO Structure variable in which the read Variable must be declared!
ASI_DATA data is to be stored.
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Output parameters

16035
Parameter Data type Description Possible values
xActive BOOL Signal confirms the FB execution FALSE Function block is inactive
TRUE FB is active (=is executed)
wCycleCount WORD Counter for FB cycles that were fully [ Number in hexadecimal representation

run through

xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

0x0000
OxnFO1
0xnF02
0xnF03
0xnF04
0xnF05

Legend:

1Get_ASi_Data executes the FB ACnnnn_SysCmd sequentially with different command IDs in order to determine the individual
elements of the complex variable. In the returned error code, the nibble n indicates the command request where the error
occurred. n can have the following values:

1 = error with "Get LAS, LDA, LPF, LCE"

2 = error with "Get LPS"
3 = error with "Get CDI"
4 = error with "Get PCD"

No specific error is set
Unknown error *
Unknown/invalid target *
Unknown command ID *
Unknown parameters *

Timeout during processing *

5 = error with "Get Input Parameter"
6 = error with "Get Output Parameter”
7 = error with "Get LCEMS, LCEAS, LDAE"
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9.1.2 Overview: System functions (FB_System)

Contents
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Get_Fieldbusinfo

Function block type: Function block (FB)

Library: ACnnnn_Utils.library

Symbol in CODESYS:

17453

—=Execute

Get_FielbusInfo

aw_InfoList F—
xReady —
*Busy F—
*Errar —
whiagnoskic F—

Description

17454

The FB reads information about the fieldbus and provides the values in a list. The following information
are read:

Status of the fieldbus

Fieldbus type

Status of the Ethernet connection at port X6 and X7
MAC addresses

IP address of the fieldbus host

Input parameters

17455

Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
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Output parameters

17456
Parameter Data type Description Possible values
aw_InfoList ARRAY]J0...18] Fieldbus information Position of the data within the individual
OF WORD words — DS18: Fieldbus information
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
XError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= OxOF01
= OxOF02
= OxOF03
= OxOF04
= OxOF05
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No specific error is set

Unknown error

Unknown/invalid target

Unknown command ID

Invalid parameters

Timeout during processing
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QuickSetupASi_Master

Function block type:
Library:
Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

—=Execute
—=Masker1
—=Master2

QuickSetupAsi_Master
*Ready
xBusy
*Errar
whiagnoskic

15999

15902
The FB executes the quick setup routine on the selected AS-i masters.
Input parameters
15903
Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
XMasterl BOOL Select AS-i master 1 for quick setup FALSE No execution of quick setup,
AS-i configuration remains
unchanged.
TRUE Execution of quick set up on
AS-i master
xMaster2 BOOL Select AS-i master 2 for quick setup FALSE No execution of quick setup,
AS-i configuration remains
unchanged.
TRUE Execution of quick set up on

AS-i master
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Output parameters

15920
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:
= 0x0000
= 0x0003

112

No specific error is set

Slave with address 0 found (slave not detected)




ifm Programming Manual SmartPLC DataLine AC14 (V4.2.x)

Appendix

1212017
Library ACnnnn_Ultils.library

Set_TimeDate

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)

ACnnnn_Ultils.library

—=Execute
—bDay
—bMonkh
— i ear
—bHour
—bMinuke
—bSecond

Set_TimeDate

xReady
wBusy
*Errar

whiagnoskic

15998

15949

The FB sets the system time (time and date) of the device using the transmitted input values.

Input parameters

15988

Parameter Data type Description Possible values
xExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
bDay BYTE Day 0x01 1
OX1F 31
bMonth BYTE Month 0x01 January
b&(OC b-ecember
wYear WORD Year 0x07B3 1971
OX07F5 | 2037
bHour BYTE Hour 0x00 0
0x17 23
bMinute BYTE Minute 0x00 0
0x3B 59
bSecond BYTE Second 0x00 0
0x3B 59
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Output parameters

15990
Parameter Data type Description Possible values
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xBusy BOOL Signal indicates if the FB is executed. | FALSE FB is deactivated or FB
execution is terminated.
TRUE FB execution is started but not
yet terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
wDiagnostic WORD Diagnostic information — List below (Diagnostic codes)

Diagnostic codes:

= 0x0000
= 0x0001
= 0x0002

114

No specific error is set

Transferred values for date/time are invalid and could not be set.

NTP active, time could not be adopted.
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913 Enumeration types and complex variables

Contents
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In addition to the standard data types, the CODESYS package from ifm electronic also features the
following enumeration types (ENUM) and complex variables (STRUCT):

Enumeration types (ENUM)

16176
The library ACnnnn_Utils provides the following enumeration types (ENUM):

ASI_ADDRESS_MODE (ENUM)

16177

Designation Description Variable Data type | Value
ASI_ADDRESS_MODE | AS-i autoaddressing mode = Auto_address_enable INT 0
= Auto_address_disable INT 1

ASI_MASTER (ENUM)

16178

Designation Description Variable Data type | Value
ASI_MASTER Identifier for AS-i masters = Master_1 INT 1
= Master_2 INT 2

ASI_MASTER_MODE (ENUM)

16179

Designation Description Variable Data type | Value
ASI_MASTER_MODE Operating mode of the AS-i master = Closed_mode INT 0
= Project_mode INT 1
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ASI_SLAVE (ENUM)

16180

Designation Description Variable Data type |Value
ASI_SLAVE Identifier for AS-i slaves = Slave_1 INT 1
= Slave_2 INT 2
= Slave_3 INT 3
= Slave 4 INT 4
= Slave 5 INT 5
= Slave_6 INT 6
= Slave 7 INT 7
= Slave_8 INT 8
= Slave 9 INT 9
= Slave_10 INT 10
= Slave_11 INT 11
=  Slave_12 INT 12
= Slave_13 INT 13
=  Slave_14 INT 14
= Slave_15 INT 15
= Slave_16 INT 16
=  Slave_17 INT 17
= Slave_18 INT 18
= Slave_19 INT 19
= Slave_20 INT 20
= Slave_21 INT 21
= Slave_22 INT 22
= Slave_23 INT 23
=  Slave_24 INT 24
= Slave_25 INT 25
= Slave_26 INT 26
= Slave_27 INT 27
= Slave_28 INT 28
= Slave_29 INT 29
= Slave_30 INT 30
= Slave_31 INT 31
ASI_SLAVE_TYP (ENUM)
16181
Designation Description Variable Data type | Value
ASI_SLAVE_TYP Type of the AS-i slave = SA Slave INT 0
= B_Slave INT 1
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Complex variables (STRUCT)

15991

The library ACnnnn_Utils.library provides complex variables of the data type STRUCT. They are
used by the FBs, but they can also be used by the programmer in CODESYS projects for the
device-internal SPS.

ASI_DATA (STRUCT)

15992
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Name Data type Description Possible values
= LDS_SA_Slave DWORD List of the active S/A slaves
Each bit represents an AS-i address:
0 = no slave active
1 = slave active
= LDS B_Slave DWORD List of active B slaves —» DS9 - Slave lists LAS, LDS, LPF, LCE,
words 4...7
= LAS_SA_Slave DWORD List of active S/A slaves
Each bit represents an AS-i address:
0 = no active slave
1 =active slave
= LAS_B_ Slave DWORD List of active B slaves —> DS9 - Slave lists LAS, LDS, LPF, LCE, words
0...3
= LPF_SA_Slave DWORD List of peripheral faults (S/A slaves) | Each bit represents an AS-i address:
0 = no peripheral fault
1 = peripheral fault
- - DS9 - Slave lists LAS, LDS, LPF, LCE,
» LPF_B Slave DWORD List of peripheral faults (B slaves) | oo” o 11
= LCE_SA_Slave DWORD List with configuration errors (S/A Each bit represents an AS-i address:
slaves) 0 = no configuration error
1 = configuration error
o ) - DS9 - Slave lists LAS, LDS, LPF, LCE,
= LCE_B_Slave DWORD List with configuration errors (B v70rds 12..15
slaves)
= LPS_SA Slave DWORD List of projected S/A slaves
Each bit represents an AS-i address:
0 = no projected slave
« LPS B Slave DWORD List of active B slaves 1= projected slave
— DS10- Slave list LPS
= LCEMS_SA Slave DWORD List of configuration errors: Each bit represents an AS-i address:
projected, but missing S/A slave 0 = no configuration error
 CEMS B S DWORD G of " " . 1 = configuration error
—B_slave p:rij o v t')%‘:ﬁifsr;ni]"g Save > DS17 - AS-i master: Error lists LCEMS,
' LCEAS, LDAE, words 0...3
= LCEAS_SA_Slave DWORD List of configuration errors:
additional S/A slave Each bit represents an AS-i address:
0 = no error
1 = error
= LCEAS_B_Slave DWORD List of configuration errors: —> DS17 — AS-i master: Error lists LCEMS,
additional B slave LCEAS, LDAE, words 4...7
= LDAE_SA_Slave DWORD List of double address errors (S/A | Each bit represents an AS-i address:
slaves) 0 = no double address error
1 = double address error
- — DS17 — AS-i master: Error lists LCEMS,
= LDAE_B_Slave DWORD List of double address errors (B LCEAS, LDAE,I words 8...11|
slaves)
= CDI ARRAYJ0..63] [Image of the current configuration | One word is available per slave:
OF WORD data Bits 0...3 = 10 code

(CDI = Configuration Data Image)

Bits 4...7 = ID code
Bits 8...11 = Extended ID1 code
Bits 12...15 = Extended ID2 code

— DS11 - Actual configuration data (CDI)
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Name

Data type

Description

Possible values

= PCD

ARRAY/[0..63]
OF WORD

Image of the projected
configuration data

(PCD = Projected Configuration
Data)

Each word contains data of one slave:
Bits 0...3 =10

Bits 4...7 = ID

Bits 8...11 = ID1

Bits 12...15 = ID2

— DS12 - Projected configuration data (PCD)

= InputParam_SA_Slave

ARRAY/[0..31]
OF BYTE

Input parameters of the S/A slaves

Each byte contains parameters of one S/A
slave:

Bits 0...3 = PO-P3

Bits 4...7 = reserved

— DS13 - Image of the input parameters of the
slaves (Pl), words 0...15

= |nputParam_B_Slave

ARRAYJ0..31]
OF BYTE

Input parameters of the B slaves

Each byte contains parameters of one B
slave:

Bits 0...3 = PO-P3

Bits 4...7 = reserved

— DS13 - Image of the input parameters of the
slaves (Pl), words 16...31

= QutputParam_SA_Slave

ARRAYJ[0..31]
OF BYTE

Output parameters of the S/A
slaves

Each byte contains parameters of one S/A
slave:

Bits 0...3 = PO-P3

Bits 4...7 = reserved

— DS14 - Image of the output parameters of the
slaves (PP), words 0...15

= OQutputParam_B_Slave

ARRAYJ0..31]
OF BYTE

Output parameters of the B slaves

Each byte contains parameters of one B
slave:

Bits 0...3 = PO-P3

Bits 4...7 = reserved

— DS14 - Image of the output parameters of the
slaves (PP), words 16...31
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ASI_NET (STRUCT)

15993

The structure contains the complete process image (inputs and outputs) of an AS-i network.

Name Data type Description Possible values
= hinlO ASI_BIN_IO Binary input and output data — ASI_BIN_IO (STRUCT) (— p. 120)
= analO ASI_ANA_IO Analogue input and output data — ASI_ANA_|O (STRUCT) (— p. 121)

ASI_BIN_IO (STRUCT)

16002

The structure contains the process data of the digital input and output slaves:

Name Data type Description Possible values

= bin_IN_Slaves ASI_BIN_IN Input data of the digital AS-i slaves | — ASI_BIN_IN (STRUCT) (— p. 120)

= bin_OUT_Slaves ASI_BIN_OUT [ Output data of the digital AS-i —-ASI_BIN_OUT (STRUCT) (— p. 120)
slaves

ASI_BIN_IN (STRUCT)

The structure contains the input data of the digital AS-i slaves:

16004

Name Data type Description Possible values
= SA_Slave ARRAY[1...31] [Input data of the digital S/A slaves, | corresponds to the 1st to 15th word of the
OF BYTE 1 byte per S/A slave acyclic data record 2 (DS2)
— D82 - Digital inputs of the slaves and master
flags
= B_Slave ARRAY[1...31] [Input data of the digital B slaves, corresponds to the 16th to 31st word of the
OF BYTE 1 byte per B slave acyclic data record 2 (DS2)
— D82 - Digital inputs of the slaves and master
flags

ASI_BIN_OUT (STRUCT)

The structure contains the output data of the digital AS-i slaves.

16003

Name Data type Description Possible values
= SA_Slave_bin_OUT ARRAY[1...31] [ Output data of the digital S/A slaves | corresponds to the 1st to 15th word of the
OF BYTE (1 byte per S/A slave) acyclic data record 5 (DS5)
— DS5 - Digital outputs of the slaves
= B_Slave_bin_OUT ARRAY[1...31] [ Output data of the digital B slaves | corresponds to the 16th to 31st word of the
OF BYTE (1 byte per B slave) acyclic data record 5 (DS5)

— D85 - Digital outputs of the slaves
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ASI_ANA IO (STRUCT)

16001

The structure contains the process data of the analogue input and output slaves.

Name Data type Description Possible values

= ana_IN_Slave ARRAY[1..31] OF Input data and status flags of the | — ASI_ANALOG_IN (STRUCT) (— p. 121)
ASI_ANALOG_ analogue AS-i slaves
IN

= ana_OUT_Slave

ARRAYJ[1..31] OF
ASI_ANALOG_OUT

Output data and status flags of the

analogue AS-i slaves

— ASI_ANALOG_OUT (STRUCT) (— p. 122)

ASI_ANALOG_IN (STRUCT)

15994

The structure contains the process data of the analogue input slave as well as the transmitted status

flags.
Designation Data type Description Possible values
= chan_1 INT Analogue value channel 1: corresponds to the 1st to 4th word of an
S or A input slave area comprising 5 words in the acyclic data
A INT anal I b ™ records 3 and 4 (DS3+4)
= chan_ nalogue value channel 2: .
S or A input slave — DS3 - Analogue inputs of slaves 1(A)...15(B)
— DS4 - Analogue inputs of slaves 16(A)...31(B)
= chan_3 INT Analogue value channel 3:
S or B input slave
= chan_4 INT Analogue value channel 4:
S or B input slave
= flags ASI_ANALOG_OUT_ Status flags — ASI_ANALOG_IN_FLAGS (STRUCT)
FLAGS (= p. 122)
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ASI_ANALOG_IN_FLAGS (STRUCT)

The structure contains the status flags of the analogue input slave.

15996

Name Data type Description Possible values

= VO BOOL Valid bit, channel 1 corresponds to the fifth word of an area

= 00 BOOL Overflow bit, channel 1 ?gg%i:ig %Edv‘fzgssgfz)e acyclic data

= V1 BOOL Valid bit, channel 2 — D83 - Analogue inputs of slaves 1(A)...15(B)
. o1 BOOL Overflow bit, channel 2 — D84 - Analogue inputs of slaves 16(A)...31(B)
= V2 BOOL Valid bit channel 3

= 02 BOOL Overflow bit, channel 3

= V3 BOOL Valid bit, channel 4

= O3 BOOL Overflow bit, channel 5

= nal BOOL -

= TOA BOOL Transfer output, S/A slave

= na2 BOOL -

= TOB BOOL Transfer output, B slave

= na3 BOOL -

= TIA BOOL Transfer input, S/A slave

= na4 BOOL -

= TIB BOOL Transfer input, B slave

ASI_ANALOG_OUT (STRUCT)

15995

The structure represents the process data of the analogue output slaves as well as the transmitted
flags.

Designation Data type Description Possible values
= chan_1 INT Analogue value channel 1: corresponds to the acyclic data records 6
S or A output slave and 7 (DS6, DS7)
+ chan 2 INT Analogue value channel 2: — DS6 - Analogue outputs of slaves 1(A)...15(B)
S or A output slave — DST7 - Analogue outputs of slaves
16(A)...31(B)
= chan_3 INT Analogue value channel 3:
S or B output slave
= chan_4 INT Analogue value channel 4:
S or B output slave
= flags ASI_ANALOG_OUT_ Status flags —-ASI_ANALOG_OUT_FLAGS (STRUCT)
FLAGS (= p. 123)
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ASI_ANALOG_OUT_FLAGS (STRUCT)

15997
The structure contains the status flags of the analogue output slave.

Name Data type Description Possible values

= nal BOOL - corresponds to the acyclic data record 8
(DS8)

Tona2 BOOL - — D88 - Status flags of analogue output data of

= pa3 BOOL - the slaves 1...31

= na4 BOOL -

= nab BOOL -

= na6 BOOL -

= na7 BOOL -

= na8 BOOL -

= OVA BOOL Output valid, S/A slave

= na9 BOOL -

= OVB BOOL Output valid, B slave

= nl0 BOOL --

= TOA BOOL Transfer Output, S/A slave

= nall BOOL -

= TOB BOOL Transfer Output, B slave

= nal2 BOOL -
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9.2 Library ACnnnn_SYS_CMD.library

Contents
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9.21 ACnnnn_SysCmd

Function block type:
Library:

Symbol in CODESYS:

Description

Function block (FB)
ACnnnn_SYS_CMD.library

15890

—xExecute

ACnnnn_SysCmd

—uCommandID

—uTargek
—pDataln
—uSizeln
—pDatacut
—uSizeCut

uZounkt F—
xReady —
xErrar F—

LErrarCode —

15893

Using the FB, individual commands can be sent to the system or to an AS-i master.
Each command refers to the data structures of one of the following elements:
e Command request channel: — Example: Change language setting of the device (— p. 130)

e Command response channel: — Example: Date / time / read NTP settings (— p. 131)

e Acyclic data record (DSx): — Example: Read LCEMS, LCEAS and LDAE of AS-i master 2 (— p. 132)

Input parameters

15895

Parameter Data type Description Possible values
XExecute BOOL Control execution of the FB FALSE Stop FB execution
TRUE Start one-time FB execution
uCommandID WORD ID of the command to be executed — Table: System commands (— p. 126)
— Table: AS-i master commands (— p. 127)
uTarget INT Device component to which the 0 system
command is to be sent -
1 AS-i master 1
2 AS-i master 2
pDataln POINTER TO Buffer for data that is assigned to the | Commando parameter described in the
WORD command as input parameters. command request channel (word 3 to 120)
uSizeln WORD Size of the buffer for the input
parameters (number of bytes)
pDataOut POINTER TO Buffer for data that is returned as Return values described in the command
WORD output parameters (results) reply channel (data as of word 5)
uSizeOut WORD Size of the buffer for the output

parameters (number of bytes)
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Table: System commands

17053

uCommandID | Description
0x0001 DS1 — System information
0x1101 Command 0x0101 — Quick set-up AS-i masters 1 + 2
0x1103 Command 0x0103 — Select user language
0x1104 Command 0x0104 — Change display settings
0x1105 Command 0x0105 — Set output control
0x1109 Command 0x0109 — Set date / time
0x110A Command 0x010A — Configure the NTP server settings
0x110B Command 0x010B — Read date / time / NTP settings
0x110C Command 0x010C — Reboot system
0x110D Command 0x010D — Read fieldbus info
0x1110 Command 0x0110 - Display target visualisation
] Only execute system commands with the input parameter uTarget = 0!
[ J

126

documentation for SmartPLC DataLine AC14 (— p. 5)).

Detailed information about the acyclic data sets and the command interface is given in the
supplement to the device manual of the SmartSPS DataLine AC14 (— Overview: User
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Table: AS-i master commands
17054

uCommandID [ Description / corresponding command

0x0002 DS2 — Digital slave inputs and master flags

0x0003 DS3 — Analogue inputs of the slaves 1(A)...15(B)

0x0004 DS4 — Analogue inputs of the slaves 16(A)...31(B)

0x0005 DS5 - Digital slave outputs

0x0006 DS6 — Analogue outputs of the slaves 1(A)...15(B)

0x0007 DS7 — Analogue outputs of the slaves 16(A)...31(B)

0x0008 DS8 — Status flags of the analogue outputs of slaves 1...31

0x0009 DS9 - Slave lists LAS, LDS, LPF, LCE

0x000A DS10 - Slave list LPS

0x000B DS11 — Current configuration data (CDI)

0x000C DS12 - Projected configuration data (PCD)

0x000D DS13 — Image of the input parameters of the slaves (Pl)

0x000E DS14 - Image of the outputs parameters of the slaves (PP)

0x000F DS15 — Slave error counter, configuration error counter, AS-i cycle counter

0x0011 DS17 — AS-i master: Error lists LCEMS, LCEAS, LDAE

0x1001 Command 0x0001 — Change AS-i slave parameters

0x1003 Command 0x0003 — Project current AS-i network

0x1004 Command 0x0004 — Change LPS

0x1005 Command 0x0005 — Change the operating mode of the AS-i master

0x1006 Command 0x0006 — Change AS-i slave address

0x1007 Command 0x0007 - Set auto address mode of the AS-i master

0x1009 Command 0x0009 — Change extended ID1 in the AS-i slave

0x100A Command 0x000A - Change PCD

0x100D Command 0x000D — AS-i master supply voltage, symmetry, earth fault

0x1015 Command 0x0015 — Read ID string of an AS-i profile (S-7.4)

0x101A Command 0x001A — Read AS-i master info

0x101C Command 0x001C — Deactivate slave reset when changing to the protected mode
0x1021 Command 0x0021 - Read diagnostics string of an AS-i slave (S-7.4)

0x1022 Command 0x0022 - Read parameter string of an AS-i slave (S-7.4)

0x1023 Command 0x0022 - Write parameter string of an AS-i slave (S-7.4)

0x1024 Command 0x0024 — CTT2 standard read

0x1025 Command 0x0025 — CTT2 standard write
0x1026 Command 0x0026 — CTT2 vendor specific read
0x1027 Command 0x0027 — CTT2 vendor specific selective write

0x1040 Command 0x0040 — CTT2 device group read

0x1041 Command 0x0041 — CTT2 device group write
0x1042 Command 0x0042 — CTT2 vendor specific selective read from buffer
0x1043 Command 0x0043 — CTT2 vendor specific selective write from buffer
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uCommandID

Description / corresponding command

128

0x1044 Command 0x0044 — CTT2 vendor specific selective read
0x1045 Command 0x0045 — CTT2 vendor specific selective write
0x1046 Command 0x0046 — CTT2 device group selective read
0x1047 Command 0x0047 — CTT2 device group selective write
0x1049 Command 0x0049 — CTT2 vendor specific exchange
0x104A Command 0x004A — CTT2 device group exchange
0x104B Command 0x004B — CTT2 device group selective read from buffer
0x104C Command 0x004C — CTT2 device group selective write from buffer
0x1050 Command 0x0050 — Set AS-i master settings
0x1051 Command 0x0051 — Reset error counter
] Only execute AS-i master commands with input parameter uTarget = 1 or 2!
°

Detailed information about the acyclic data sets and the command interface is given in the
supplement to the device manual of the SmartSPS DatalLine AC14 (— Overview: User

documentation for SmartPLC DataLine AC14 (— p. 5)).
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Library ACnnnn_SYS_CMD.library

Output parameters

15897
Parameter Data type Description Possible values
uCount WORD Number of valid bytes in pDataOut integer value in hexadecimal
(uCount <= uSizeOut) representation
xReady BOOL Signal indicates if the execution of the | FALSE FB is inactive or being
FB is terminated. executed.
TRUE FB execution is terminated.
xError BOOL Signal indicates if errors occurred FALSE FB is disabled or presently
while the FB was executed. executed or FB was executed
without error.
TRUE An error occurred when the FB
was executed.
uErrorCode WORD Error code of the executed command | Command error code of the corresponding
command channel
OR: — List below (Diagnostic codes)

Diagnostic codes:

= 0xnFO1 Unknown error *

= OxOF02 Unknown/invalid target

= OxOFO03 Unknown command 1D

= OxOF04 Invalid parameters

= OxOF05 Timeout during processing
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Library ACnnnn_SYS_CMD.library

Example: Change language setting of the device

17051

Task: Set the language of the graphic user surface of the device to "Spanish" with the FB
ACnnnn_SysCmd.

Command type: Command request channel

Input parameters of the FB:

Parameter Value Explanation

uCommandID 0x1103 Corresponding commando channel:
— Command 0x0103 - Select user language (— device manual supplement)

uTarget 0 System command

pDataln arDataln = Variable of the data type Array of Words
= arDataln contains the command parameters

uSizeln 0x0001 arDataln only consists of 1 line since word 1 and 2 as well as 4 to 120 of the command
request channel are not considered.

pDataOut - irrelevant since command request channel

uSizeOut - irrelevant since command request channel

Content of arDataln:

Word no.

Contents

Explanation

1

0x4553

Spanish
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Example: Date / time / read NTP settings

17423
Task: Read the current system time and the NTP settings with the FB ACnnnn_SysCmd.
Command type: Command reply channel
Input parameters of the FB:

Parameter Value Declaration
uCommandID 0x110B Corresponding commando channel:
— Command 0x010B - Read date / time / NTP settings (— device manual supplement)
uTarget 0 System command
pDataln -- irrelevant, since command reply channel
uSizeln - irrelevant, since command reply channel
pDataOut arDataOut = variable of the data type Array of Words

= contains the return values of the reply channel

uSizeOut 0x0007 Array consists of 7 lines since the reply channel returns 7 words (words 5 ... 11).

Content of arDataOut:

Word no. Content
1 Month Day
2 Year Year
3 Minutes Hours
4 reserved Seconds
5 NTP offset NTP status
6..7 IP address NTP server
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Library ACnnnn_SYS_CMD.library

Example: Read LCEMS, LCEAS and LDAE of AS-i master 2

17424

Task: Read the error lists LCEMS, LCEAS and LDAE of the AS-i master 2 with the FB
ACnnnn_SysCmd.

Command type: acyclic data set

Input parameters of the FB:

Parameter Value Declaration
uCommandID 0x0011 Corresponding acyclic data set:
— DS17 - AS-i master: Error lists LCEMS, LCEAS, LDAE (— device manual supplement)
uTarget 1 Master command (1 = AS-i master 2))
pDataln -- irrelevant
uSizeln - irrelevant
pDataOut arDataOut = Variable of the data type Array of Words
= contains the return values
uSizeOut 0x000C Array consists of 12 lines since the data set DS17 has exactly 12 words

Content of arDataOut:

Word no. Content
1..4 LCEMS (list of configuration errors - missing slaves)
5..8 LCEAS (list of configuration errors - additional slaves)
9..12 LDAE (list of double address errors)
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